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Аннотация 
 

Сборник задач по дисциплине «Мультимедиа 
технологии» предназначен для обучающихся по 
направлению 10.03.01 «Информационная 
безопасность» очной формы обучения. 
 

Обучающиеся, завершившие изучение 
дисциплины «Мультимедиа технологии» должны 
обладать следующими навыками в соответствии с 
ФГОС ВО: 

способностью сбора, проведения анализа и 
понимания значения современной научно-технической 
информации по исследуемым проблемам и задачам; 

навыками к самоорганизации и самообразованию; 
приемами саморегуляции эмоциональных и 

функциональных состояний при выполнении 
профессиональной деятельности; 

навыками оформления полученных результатов, 
научно-технических отчетов, статей и докладов на 
научно- технических конференциях; 

успешным и систематическим применение 
навыков программных средств системного, 
прикладного и специального назначения, 
инструментальных средств, языков и систем 
программирования для решения профессиональных 
задач. 

Авторы 
к.т.н., доцент кафедры «Вычислительные си-
стемы и информационная безопасность» 
Айдинян А.Р. 
ассистент Панасенко Н.Д. 
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ЛАБОРАТОРНАЯ РАБОТА № 1 ОСНОВЫ РАБОТЫ В ПАКЕТЕ 

СОЗДАНИЯ МУЛЬТИМЕДИА-ПРОДУКТА. СОЗДАНИЕ 

ИЗОБРАЖЕНИЙ И БИБЛИОТЕК СИМВОЛОВ В 

ПРОГРАММНОМ СРЕДСТВЕ СОЗДАНИЯ МУЛЬТИМЕДИА-

ПРОДУКТА (ВЕКТОРНАЯ ГРАФИКА) 

 

Цель работы изучить основные инструменты на панели 
инструментов. Получить навыки создания изображений. Научить-

ся создавать и редактировать символы и текстовые оформления, 
изменять свойства экземпляров символов в клипе. 

 
Краткие теоретически сведения 

Инструменты выделения 

А. Инструмент «Selection» («Выделение») –этот 

инструмент позволяет нам выбрать на монтажном столе произ-
вольную область прямоугольной формы, все объекты, и части 

объектов попавшие в эту область. 
 
Упражнение 1: Выделите круг и переместите его в 

другое место монтажного стола. 
1. Нарисуйте круг. 

2. Выберите инструмент «Selecrion». 
3. Растяните область выделения, удерживая нажатой 

левую кнопку– мыши, так чтобы выделился весь круг. Обратите 

внимание, что выделенные элементы изменяют свой цвет, как бы 
покрываясь сеточкой. 

4. Если на выделенном объекте нажать и удерживать 
левую кнопку мыши, то. двигая курсором, мы сможем изменять 

положение выделенного фрагмента. 
Если мы просто щёлкнем курсором по какой–либо отдель-

ной части нашего рисунка – выделится именно эта часть. 

 
Упражнение 2: Изменить форму объекта(круга). 
1. Наведите курсор на границу не выделенного объекта, 

около стрелочки появляется изображение дуги. 

2. Нажав и удерживая левую кнопку мыши, измените 

форму объекта. 
 

При выборе инструмента «Selection», в разделе «Options» 
появляются три дополнитель- ные кнопки 
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Кнопка  «Snap to Object» («Привязка к объекту») – 
позволяет связывать перемещаемый объект с другим 

Кнопка  «Smooth» («Сглаживание») – сглаживает 

ломаную линию, преобразуя ее в кривую. 

Кнопка «Straighten» («Выпрямление») – уменьшает 

изогнутость линии. 

В. Инструмент  «Subselection» («Лодвыделенне») – 

позволяет выделить объект или несколько объектов целиком  
 
Упражнение 3: Изменить форм объекта (круга). 
1. Выберете инструмент «Subselection». Все объекты, 

хоть краем попавшие в область выделения, оказываются полно-

стью выделенными. 
2. Выделите круг. Выделенный объект окаймляется зе-

леной линией, на которой имеются небольшие зеленые точки, 
иначе называемые углами. Если навести курсор на узел, курсор 

изменится н приобретет вил острого треугольника 

3. Нажмите левую кнопку мыши и удерживая ее. движе-
ниями курсора перетаскивайте отдельные узлы, меняя форму 

объекта. 
 

С. Действия инструмента  «Lasso» («Лассо») схоже с 

действием инструмент «Selection». При выделении инструментом 
«Lasso» выделяется не прямоугольная, а произвольная область. 

 
Инструменты модификации 

Инструмент  «Free Transform» («Свободная транс-

формация») – позволяет применять различные способы транс-
формации объекта. 

 
Упражнение 4: Измените форму прямоугольника, 

поверните его под любым углом. 
1. Нарисуйте прямоугольник 
2. Выберите инструмент "Free Transform» 

3. Выделите прямоугольник при помогли инструмента 
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«Free Transform» путем растягивания области выделения. Вокруг 

прямоугольника образовалась черная рамка с небольшими чер-

ными квадратиками на углах. 
4. Нажав и удерживая левую кнопку мыши на любом из 

этих квадратиков и двигая курсор, растягивайте прямоугольник в 
любую сторону 

5. При приближении курсора к одному из углов выделе-
ния, курсор принимает вид круглой стрелки. Нажав и удерживая 

левую кнопку мыши, двигайте курсор, чтоб вращать прямоуголь-

ник. 
 

В разделе «Options» имеются дополнительные кнопки. 

Кнопка  «Rotate and Skew» («Поворот н наклон») –

доступной трансформацию вращения и наклона, гд 

Кнопка «Scale» («Растяжение») – позволяет сделать 

доступной трансформацию масштабирования. 

Кнопка  «Distort» («Искажение») – позволяет сделать 

доступной трансформацию искажения перспективы 

Кнопка  «Envelope» («Изгиб») – позволяет сделать 
доступной трансформацию изгиба. Рисование линий 

 
Рисование линий 

 

D. Рассмотрим инструменты рисования на панели инстру-

ментов. Начнем наше изучение с инструмента  «Line» («Ли-

ния»). Этот инструмент позволяет рисовать нам прямые линии. 

Обратите внимание, что свойства на панели «Properties» соответ-
ствуют выбранному инструменту. Так, на панели «Properties» мы 

можем выбрать толщину линии, изменить тип линии и поменять 
цвет линии Цвет линии можно также выбрать н на панели ин-

струментов. 

 
Упражнение 5: Нарисуйте прямую. 
Для этого нужно нажать и удерживать левую кнопку мыши 

на рабочем поле и, не отпуская кнопки мыши, протянуть курсор в 

нужном направлении. 
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E. Следующий инструмент – «Реп» («Перо») Он поз-
воляет рисовать кривые от точки к точке. 

 

Упражнение 6: Нарисуйте кривую 
1. Щелкайте левой кнопкой мыши в разных точках рабо-

чего поля и они. соединяясь линиями, образуют ломаную. 
2. Нажмите левую кнопку мыши, удерживайте ее и пере-

двигая курсором, сможете установить кривизну линии. На панели 
«Properties» находятся те же атрибуты, что и при выделенном 

инструменте «Line» 

3. Если вы замкнете кривую, нарисовав тем самым фигуру, 
то внутренности фигуры будут окрашены в цвет заливки. 

 
Рисование фигур 

Инструментами рисования можно создавать не только ли-

нии, но и фигуры произвольной формы. 
 

F. Инструмент  «Rectangle» («Прямоугольник»). 
Этот инструмент позволяет рисовать прямоугольник, а если удер-

живать клавишу «Shift», то квадрат. 

 

G. Аналогично инструмент  «Oval» («Овал»). 
 

Упражнение 7: Нарисуйте прямоугольник. 
 
Упражнение 8: Нарисуйте овал. 
Упражнение 9: Нарисуйте прямоугольник с закруг-

ленными краями 
1. Ha панели инструментов, в разделе «Options». 

нажмите новую кнопку «Set Corner Radius» («Установить радиус 
угла») и в открывшемся окне введите значение радиуса угла. 

2. Нажмите «ОК». 
 

Упражнение 10: Нарисуйте  многоугольник. 
1. Нажмите на кнопку инструмента «Rectangle» н 

удерживайте 
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нажатой кнопку мыши. В выпавшем меню выберите другой 

инструмент – «PolyStar» («Многоугольник»). 

2. Этот инструмент позволяет рисовать многоугольник 
 

Упражнение 11: Нарисуйте многоугольник– звезду. 
1.Нарисуем многоугольник. 

2.Обратнте внимание, на панели «Properties» появилась 
кнопка «Options» («Опции»). Нажмите ее. 

З.В выпадающем меню «$tу1е» («Стиль») выберите стиль 

многоугольника. Здесь предложено два варианта «Polygon» 
(«Многоугшьник») и «Star» («Звезда»). Выберите вариант «Star» 

Ниже в поле «Number of Sides» («Число сторон») введите число 
сторон нашего многоугольника. 

4. Поле «Star point size» («Размер нейтральной точки 

звезды») задает степень остроты углов звезды. Чем меньше это 
значение, тем ближе будут утлы к центру. В случае если выбрана 

не звезда, а прямоугольник, значение в этом поле не будет вли-
ять на внешний вид фигуры. Нарисуем звезду с малым показате-

лем «Star point size». для этого введем значение 0.1. (Измените 
показатели на 1– это максимально тупой угол звезды). 

5.Нажмите «ОК» 

 

Н. Инструмент  «Pencil» («Карандаш») позволяет ри-

совать произвольные кривые. Кривая рисуется движением курсо-
ра при нажатой левой кнопке мыши. Этот инструмент является 

средством для рисования различных контуров. На панели 
«Properties» у инструмента «Pencil» можно настроить цвет, тол-

щину и тип рисуемой линии. В разделе «Options» находится кноп-

ка, позволяющая изменить степень сглаживания кривой. 
 

Кнопка  «Ink» («Чернила») – сглаживания практиче-
ски не будет. 

Кнопка  «Straighten» («Выпрямление») – сглажива-
ние будет максимальным. 

Кнопка  «Smooth» («Сглаживание») – этот вариант 
является промежуточным, сглаживание будет средним. 

Упражнение 12: Нарисуйте инструментом карандаш 
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произвольный Рис. 
 

I. Инструмент «Brush» («Кисть») является имитаци-
ей художественной кисти. Рисуемые ими линии и объекты явля-

ются не контурами, а заливкой. 
 
Упражнение 13: Нарисуйте линию инструментом 

Кисть. 
1. В разделе «Options» на панели инструментов измени-

те размер кисти. Раскройте выпадающее меню «Brush Size» 
(«Размер кисти») и в выпавшем меню выберите максимальный 

размер кисти. 

2. Также можно изменить форму кисти. Раскройте выпа-
дающее меню «Brush Shape» («Форма кисти») и выберите самый 

нижний из типов кисти, в виде сильно наклоненной палочки.  
3. На панели «Properties» выберите цвет кисти. Обрати-

те внимание, цвет кисти – это цвет заливки, а не цвет контура. 
4. Нарисуйте линию. 

 

J. Инструмент  «Ink Воtt1е» («Бутылка чернил») 
позволяет нарисовать контур у объекта однородного цвета. кото-
рый представляет собой заливку Для применения инструмента 

нужно щелкнуть курсором на нужном объекте. На панели 

«Properties» можно выбрать тип контура, его цвет и толщину. 
 
Упражнение 14: Измените цвет и форму контура у 

любого объекта. 
 

К. Инструмент  «Paint Bucket» («Ведерко краски») 
окрашивает в выбранный цвет заливки объекты, ограниченные 

контуром, или однотонные объекты. Для применения этого ин-
струмента нужно щёлкнуть внутри замкнутого контура нли на од-

нотонном объекте. На панели «Properties» доступен только выбор 

цвета заливки. На панели инструментов, в разделе «Options» 
нажмите кнопку «Gap Size» («Размер промежутка»). В этом меню 

можно указать, насколько должен быть замкнут контур, чтобы 
можно было залить его внутри при помошн инструмента «Paint 

Bucket». 
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Упражнение 15: Измените цвет заливки у любого 
объекта. 

 

L. Инструмент  «Еуеdroрреr» («Пипетка») позволяет 

нам выбрать необходимый цвет из имеющихся объектов на мон-

тажном столе. Для выбора пвета достаточно щелкнуть прямо на 
изображении. При этом если щелчок был сделан на контуре, из-

менится цвет контура, а если щелчок был сделан на заливке, то 
изменится цвет заливки. 

 

Внимание, цвет кисти – это цвет заливки, а не цвет 
контура. 

 

М. Инструмент  «Eraser» («Ластик») позволяет сти-

рать произвольные области объектов. В разделе «Options» на па-
нели инструментов можно изменить размер и форму ластика. Рас-

кройте меню «Eraser shape», в выпадающем меню выберите мак-

симальный размер круглой старательной резинки. 
 
Упражнение 16: Рассмотрите все способы работы 

инструмента Ластик. 
 
Упражнение 17. Начальные сведения о рисовании 
Выполнить действия, описанные в уроке “Рисование.fla”. 

 
Задание 1 

Сохраните вашу работу под именем «Практика по лабора-
торной работе № 1». Создайте отчет. 

 

Инструменты рисования 
Инструменты рисования можно разделить на три типа: ин-

струменты, задающие одновременно и контуры, и заливки; ин-
струменты создающие только контуры и инструменты, создающие 

только заливки. 

К инструментам первого типа относятся инструменты Oval 
(овал) и Rectangle (прямоугольник). Цвета контура и заливки 

определяются установленными к моменту использования этих ин-
струментов. 

Для определения свойств рисуемых объектов инструменты 
имеют модификаторы в области Options (настройки), а также 
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панель Properties в нижней части окна. Инструмент Rectangle 

имеет модификатор Round Rectangle Radius (радиус скругления 

углов). В панели Properties (в нижней части окна) можно выби-
рать цвет и другие свойства фигуры. 

Для получения правильной геометрической фигуры (круга 
или квадрата) необходимо удерживать нажатой клавишу Shift. 

Ко второму типу инструментов рисования относятся 
Pencil (карандаш), Line (линия) и Pen (перо). 

Инструмент Line используется для рисования прямых ли-

ний. Инструмент Pencil в отличие от инструмента Line, вычерчи-
вает всю траекторию движения мыши и имеет следующие режи-

мы рисования: 
– Straighten (выпрямление) позволяет преобразовать 

нарисованную линию в ломанную;  

– Smooth (сглажевание) позволяет сгладить нарисован-
ную линию; 

– Ink (чернила) оставляет нарисованную линию без из-
менений. 

Для получения линии под углом расположения кратным 
45о удерживайте нажатой клавишу Shift при рисовании. 

Инструмент Pen (перо) предназначен для рисования кри-

вых Безье. 
Инструмент Eraser (ластик) используется для удаления 

произвольной части объекта и имеет форму круга или квадрата, 
каждый из которых в свою очередь имеет до пяти размеров.  

Модификаторы инструмента Eraser (ластик): 

– Erase Normal (обычное стирание) – стираются все ли-
нии и заливки на активном слое.  

– Erase Fills (стирание заливки) – стирается только за-
ливка, не затрагивая линии.  

– Erase Lines (стирание линий) – стираются только ли-

нии, не затрагивая заливку.  
– Erase Selected Fills (стирание выделенных заливок) – 

стираются только выделенные перед началом данной операции 
заливки. Линии не затрагиваются, даже если они выделены.  

– Erase Inside (стирание внутри) – стираются только те 
заливки, с которых вы начали данную операцию. Если Вы начали 

стирать внутри контура, который не имеет заливки, то ничто не 

будет стерто. 
Для рисования заливок используется инструмент Brush 

(кисть), который выводит штрихи, как будто вы красите кистью. 
Этот инструмент позволяет создавать специальные эффекты, 
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включая каллиграфические эффекты и раскрашивание изображе-

нием импортированного растрового рисунка.  

Форму нарисованной фигуры можно изменить, потянув 
курсором мыши границу невыделенной фигуры.  

Для изменения цвета и других свойств существующей за-
ливки используется инструмент Рaint bucket (ведро с краской). 

Для изменения цвета и других свойств контура – инструмент Ink 
bottle (бутылка чернил).  

Заливка бывает четырех типов: сплошная, радиальная, 

линейная и растровая. Создание типа заливки осуществляется в 
панели Color Mixer, которая открывается через пункт меню 

Window→Design Panels→Color Mixer. 
Инструмент Transform Fill служит для изменения геомет-

рических свойств линейной, радиальной и растровой заливок. Для 

этого после выбора инструмента необходимо щелкнуть на заливке 
и управлять соответствующими появившимися маркерами (рис. 

1). 

          

 
Рис.1.1. Виды маркеров для разных видов заливки 

(линейная, радиальная и растровая) 

 
Инструмент Selection (стрелка) служит для выделения 

контура или заливки, а также для изменения формы фигуры (если 
она не выделена).  

 

Символ 
Символ – особый объект, который создается один раз, и 

затем неоднократно используете в проекте. Символом может быть 
что угодно – от нарисованного рисунка до анимации. Символы 

позволяют сократить размеры конечного файла фильма и упро-

стить его редактирование. Символы также требуются для созда-
ния интерактивных фильмов. 

Любой созданный сим- вол автоматически попадает в 
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библиотеку. Для использования символа в проекте необходимо 

перетащить символ из библиотеки в проект. Причем в библиотеке 

будет храниться оригинал символа, а в проекте его экземпляр, 
который занимает мало места. Представление символа в фильме 

называется экземпляром символа. 
Каждый символ имеет свою рабочую область и свою шка-

лу времени. Таким образом, символы можно рассматривать как 
маленькие фильмы, экземпляры которых размещены внутри ва-

шего проекта. 

Имеется 3 типа символов: 
– графика (graphic symbols) – статическая (неанимирован-

ная) графика. 
– клипы (movie-clip symbols) – независимый фильм, содер-

жащий все элементы главного фильма, включая звук, анимацию и 

кнопки. 
– кнопка (button symbols) – реагирует на движение курсо-

ра мыши и реализуют интерфейс с пользователем. 
Символы можно создавать следующим образом: 

1) преобразованием элементов рабочей области (выдели-
те эти элементы и выберите пункт меню Insert→Convert to 

Symbol. В диалоговом окне выберите имя символа и тип); 

2) созданием пустого символа, который затем заполнить 
содержимым. Для этого выберите пункт меню Insert→New 

Symbol. В диалоговом окне выберите имя символа и тип. После 
этого автоматически осуществляется переход в режим редактиро-

вания символа. Для выхода из режима редактирования символа в 

режим редактирования сцены выберите пункт меню Edit→Edit 
Movie; 

3) можно использовать символы из других фильмов. Для 
этого выберите пункт меню File→Open as Library. 

Выберите пункт меню Window→Library, чтобы открыть 

окно библиотеки и убедиться в том, что новый символ был добав-
лен в библиотеку. 

Символ можно отредактировать в любой момент. После 
редактирования символа все экземпляры этого символа также 

меняются.  
Для редактирования символа дважды щелкните на экзем-

пляре символа, находящегося на рабочем столе, или выберите 

пункт меню Edit in Place или Edit in new window.  
Для редактирования свойств экземпляра символа (без из-

менения символа) служит панель Property. В ней можно изме-
нять цвет, размеры, тип экземпляра. Также свойства экземпляра 
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можно менять с помощью инструмента Free Transform.  

 

Текст 
Текст вводится, содержится и обрабатывается в текстовом 

блоке. Текстовые блоки могут быть трех типов: 
– Static Text используется как для создания объектов 

анимации, так и для вывода на экран текстового сопровождения; 
– Input Text предназначен для взаимодействия с пользо-

вателем, просматривающем анимацию;  

– Dynamic Text предназначен для отображения на 
экране результатов работы программы Flash. 

Текстовые блоки Input Text и Dynamic Text используют-
ся для того, чтобы анимация стала интерактивной. Текстовый 

блок Static Text широко используется для создания графических 

изображений.  
Создать текстовый блок можно с помощью инструмента 

Text (Текст). После выбора инструмента Text щелкните в рабо-
чей области. Появится однострочный текстовый блок. По мере 

ввода текста ширина блока будет автоматически увеличиваться, 
пока вы для перехода на новую строку не нажмете на клавишу 

Enter. Такой блок называется блоком фиксированной высо-

ты.  
Если при создании текстового блока растянуть его, задав 

ширину блока, то длина строки остается постоянной. Слова в та-
ком блоке переносятся автоматически, увеличивая тем самым ко-

личество строк. Такой блок называется блоком фиксирован-

ной ширины. 
Панель Properties для текстового блока предлагает 

обычный набор возможностей для форматирования, позволяя вы-
бирать шрифт, размер кегля, стиль, интервал, цвет и тип вырав-

нивания. С помощью инструмента Free Transform можно транс-

формировать текст как объект – вращать, масштабировать, сдви-
гать и зеркально отражать его, сохраняя возможность редактиро-

вания символов.  
Для изменения формы, заливки и других манипуляций, 

текст конвертируется в его графическое представление с помо-
щью пункта меню Modify→Break Apart (2 раза). Символы вы-

бранного блока будут сконвертированы в графические формы на 

рабочем поле. 
После конвертирования текста в графическое представле-

ние, редактировать его как текст уже невозможно.  
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Задание 2. Создание кружевного узора 
1. Чтобы нарисовать ажурную «снежинку» или звезду, 

сначала создадим вспомогательный шаблон (рис.1.2а). Для этого 
нарисуем вытянутый прямоугольник. Используя инструмент 

Selection, удалим из нарисованного шаблона заливку и слегка 
деформируем контур.  

2. Следующим шагом, используя инструмент Transform, 
перенесем центр вращения, на короткую сторону нарисованного 

шаблона.  

3. После этого на панели Transform (Windows→Desing 
Panels→Trasform) зададим угол поворота копии Rotate 18о. 

Несколько раз нажмите кнопку Copy And Apply Transform на 
этой панели. При каждом нажатии этой кнопки появляется новая 

копия шаблона, повернутая на заданный угол относительно 

предыдущей копии. 
На рис. 1.2б представлен полученный кружевной узор. 

     
а              б 

Рис.1.2. Создание кружевного узора 
 

Задание 3. Букет цветов 
1. Нарисуйте небольшой овал произвольного цвета, кото-

рый впоследствии станет основой лепестка и листа цветка (рис. 

1.3а).  
2. Не выделяя овал, слегка измените его форму (рис. 1.3б) 

инструментом Selection. Для этого поднесите курсор к овалу и 
«поймайте» момент, когда около курсора появится небольшая 

дуга. Эта дуга показывает готовность овала к деформации. Для 

деформации нажать на кнопку мыши и немного перенести.  
3. Выделите деформированный овал инструментом 

Selection. Удерживая клавишу Ctrl, перенесите его на другое 
место. 

4. Выделите полученную копию инструментом Free 

Transform. Она окажется окруженной вспомогательным прямо-
угольником, на котором находятся несколько маркеров.  

5. Поднесите курсор к угловому маркеру и «поймайте» 
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момент, когда около этого маркера появится дугообразная стре-

лочка, что показывает готовность к повороту. Поверните копию 

на угол порядка 10о. 
6. Перенесите повернутую копию и наложим её на ориги-

нал. Для этого воспользуемся инструментом Selection. Получено 
два лепестка. 

7. Продолжите процедуру копирования до тех пор, пока 
количество лепестков не станет достаточным. На каждом этапе 

можно слегка изменить форму лепестков. 

8. Измените цвет каждого лепестка инструментом Paint 
bucket. 

9. Листья рисуются аналогично лепесткам. Для создания 
листьев используется та же заготовка. 

10. Выделите весь цветок с помощью инструмента 

Selection и создадим несколько его копий. Для этого, удерживая 
клавишу Ctrl, перенесите изображение. 

11. Измените пропорции и размеры каждой копии, чтобы 
придать ей индивидуальность. 

12. Сдвиньте все копии поближе и получите букет (рис. 
1.3). 

 

Рис.1.3. Преобразование овала в букет цветов 

 
Задание 4. Радуга 

1. Нарисуйте круг в центре рабочего листа (рис. 1.4а). 
2. Выполните радиальную заливку круга. Для создания ра-

диальной заливки используется панель Color Mixer 

(пункт меню Window→Design Panels→Color Mixer). 
Расположите заливку в центре с помощью инструмента 

Transform (рис. 1.4б). 
3. Нарисуйте горизонтальную линию по центру круга (рис. 

1.4в). Снимите выделение и удалите линию и нижнюю 
часть круга. 

4. Нарисуйте круг радиусом меньше первого. Наложите 

нарисованный круг на оставшуюся половину первого кру-
га. Затем удалите центр оставшейся половины круга. 

5. Отмасштабируйте радугу, растянув по горизонтали (рис. 
1.4г). 
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Рис.1.4. Этапы создания радуги 

 

Задание 5. Витраж 
1. Создайте рабочий лист размером 400х400 

(Modify→Movie). 
2. Нарисуйте в центре листа круг радиусом 150 (300х300) 

и радиальной заливкой. При помощи панели Info 

(Windows→Desing Panels→ Info) или панели Properties мож-
но точно выставить координаты круга. 

3. Для получения фигуры на рис. 1.5 нарисуйте круг раз-
мером 100х100 в стороне от первого круга. Совместите его с пер-

вым кругом точно по координатам (200, 50). Снимите выделение, 

выделите и сместите в другое место (по координатам 50, 200), 
снимите выделение, выделите и сместите аналогично в три дру-

гие позиции. Удалите второй круг. 
4. Добавьте к фигуре контур зеленого цвета при помощи 

Ink Bottle, щелкнув на внешней границе. 
5. Выделите весь контур с помощью инструмента Selection 

двойным щелчком. Отмасштабируйте на 90% и поверните контур 

на 45 градусов при помощи панели Trasform (пункт меню 
Windows→Desing Panels→Trasform) (рис. 1.5). 

6. Выделите контур и превратите его в заливку 
(Modify→Shape→ Convert Lines To Fills). Выберите линейную 

заливку и залейте контур (рис. 1.5). 

7. Затем инструментом Transform измените расположе-
ние заливки. 

8. Осуществите модификацию, представленную на рис. 
1.5. 

 

 
Рис.1.5. Этапы создания витража 
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Задание 6. Привидения 

1. Нарисуйте привидение, изображенное на рис. 1.6. 

2. Для того чтобы создать символ дважды щелкните на 
изображении привидения в рабочей области, выделив его, и вы-

берите команду Modify→Convert to Symbol. 
3. В диалоговом окне Properties в качестве имени символа 

введите «ghost» и нажмите Enter. Теперь изображение привиде-
ния в рабочей области стал экземпляром символа, пока с нулевы-

ми изменениями. 

4. Снимите выделение, а затем вновь выделите экземпляр 
символа ghost и перетащите его. Обратите внимание, что экзем-

пляр перемещается как единый объект, а не как отдельные обра-
зующие его фигуры. 

5. Выберите команду Window→Library (Библиотека). От-

кроется окно библиотеки. Обратите внимание, что созданный 
символ появился в списке объектов окна библиотеки наряду с 

прочими символами текущего фильма. Экземпляр созданного 
символа можно использовать в любой части фильма.  

6. Перетащите символ привидения из окна библиотеки в 
рабочую область. При каждом перетаскивании создается новый 

экземпляр символа. 

7. Создайте несколько экземпляров. 
8. Используйте модификаторы Scale (Масштаб) и Rotate 

(Вращение) инструмента Selection, чтобы менять размеры и угол 
поворота созданных экземпляров символа (рис. 1.7).  

9. Измените яркость, контрастность или прозрачность эк-

земпляров. Для этого выделите экземпляр в панели Properties, 
выберите параметры Color: Tint (Оттенок). Укажите, например, 

зеленый цвет в палитре цветов и передвиньте ползунок Tint на 
значение 50% (100% соответствует полной закраске символа вы-

бранным цветом). 

10. На панели Properties символ можно сделать полупро-
зрачным. Выделите один из экземпляров и выберите пункт Alpha 

(Прозрачность). Необходимо получить изображение, представ-
ленное на рис. 1.8. 
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Рис. 1.6. Привидение 

 
Рис. 1.7. Экземпляры символа 

 

 
Рис. 1.8. Результат выполнения  

 
Задание 7. Текст с градиентной заливкой 

Создадим текст с градиентной заливкой, представленный на 
рис. 1.9. 

1. Создайте новый клип. Установите размер клипа через 

пункт меню Modify→Document ... (Dimensions 350х160 px) . 
2. Нарисуйте фоновый прямоугольник размером 350х160px 

и разместить левый верхний угол по координатам 0,0. (Точный 
размер и положение можно задать через панель Info). 

3. Задайте заливку фона в виде радуги.  

4. Создайте текстовое поле на новом слое.  
Слои похожи на прозрачные листы, сложенные стопкой 

друг на друга. Когда вы создаёте новый клип, он содержит один 
слой. Вы можете добавить новые слои для удобства работы с 
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изображениями, анимацией и другими элементами клипа, при 

этом можно рисовать и редактировать объекты на одном слое, не 

затрагивая объекты на других слоях. Через пустые места на слое 
видны объекты, которые находится слоем ниже. 

Слои можно скрывать, блокировать или показывать только 
контуры содержимого слоя (outlines), так же можно менять по-

рядок расположения слоёв относительно друг друга. 
Чтобы создать слой, воспользуйтесь кнопкой Insert Layer 

внизу монтажной линейки. 

Чтобы рисовать на слое или изменять его параметры, он 
должен быть активным. Значок-карандаш, находящийся справа от 

названия слоя, указывает, что слой активен.  
5. Сделайте слой Layer 2 активным. Добавьте текст во 

второй слой. 

6. Используйте панель Character для выбора шрифта, 
размера, стиля и цвета. 

7. Для изменения формы и других манипуляций сконвер-
тируйте текст в его графическое представление (пункт меню 

Break Apart выполнить 2 раза).  
8. Для осуществления радиальной заливки верхней части 

букв, отличной от нижней, необходимо разбить текст на две части 

волнистой линией. Для этого выберите инструмент Pencil цвета, 
отличного от цвета текста (и выберите модификатор Ink). Таким 

образом, каждая буква будет разбита на верхнюю и нижнюю ча-
сти. Отмените выделение линии и удалите ее. 

9. Выберите линейную заливку и залейте ею верхние ча-

сти букв. При необходимости откорректируйте геометрические 
свойства заливок каждой части инструментом Fill Transform. Для 

масштабирования линейного градиента или заливки, перетащите 
квадратный маркер в центре блока ограничения. 

 

  

  
Рис.1.9. Этапы получения текста с градиентной заливкой 
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Задание 8. Контурный текст 

Создадим контурный текст, представленный на рис. 1.10. 

1. Установите размер клипа 340х200px.  
2. На первом слое введите текст шрифтом Arial Cyr полу-

жирный, синего цвета размером 88 пунктов c трекингом 11. 
3. Выделите текст с помощью инструмента Selection. Вы-

полните команду Modify→Break Apart.  
4. Инструментом Ink Bottle добавьте контур серого цвета 

вокруг букв (выберите серый цвет и щелкните на внешнем конту-

ре букв). 
5. Удерживая Shift, выделите контуры всех букв и скопи-

руйте их на второй слой. Измените цвет линии на черный и уста-
новите толщину линии равной единице. 

6. Совместите контур букв во втором слое с контуром букв 

на первом слое (с помощью клавиш стрелок или мыши). 

   
Рис.1.10. Текст с контуром 

 

Задание 9. Задание для самостоятельного выполнения 
 

 
Рис. 1.11. Звезда 

 

 
Рис. 1.12. Галактика 
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Рис.1.13. Произвольная работа с текстом 

 
Контрольные вопросы 

 
1. Понятие мультимедиа и области его применения. 

2. Какие инструменты служат для выделения? 

3. Какие инструменты служат для рисования? 
4. Какие свойства имеются у инструментов «Заливка» и «Ла-

стик»? 
5. Какие имеются возможности для модификации объектов? 

6. Инструменты для рисования линий, прямоугольников и ова-
лов. 

7. Инструменты Pen, Pencil и Brush и их модификаторы. 

8. Инструменты для изменения свойств контура и заливки фи-
гуры. 

9. Модификаторы Paint mode и Eraser mode. 
10. Инструмент Eraser и его модификаторы. 

11. Инструменты для выделения. 

12. Модификатор Smooth. 
13. Способы изменения формы и свойств линий и заливок. 

14. Панели Transform и Info. 
15. Понятие символа и его виды. 

16. Экземпляр символа. 

17. Способы создания текстовых полей. 
18. Изменение свойств текстового поля с помощью панели 

Character. 
19. Преобразование текста в фигуру. 

20. Общие характеристики шрифтов. 
21. Классификация шрифтов и их характеристики. 

22. Форматы текстовых файлов.  

23. Гипертекст и гипермедиа. 
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ЛАБОРАТОРНАЯ РАБОТА № 2 ОСНОВЫ РАБОТЫ В ПАКЕТЕ 

СОЗДАНИЯ МУЛЬТИМЕДИА-ПРОДУКТА. СОЗДАНИЕ 

ИЗОБРАЖЕНИЙ И БИБЛИОТЕК СИМВОЛОВ В 

ПРОГРАММНОМ СРЕДСТВЕ СОЗДАНИЯ МУЛЬТИМЕДИА-

ПРОДУКТА (РАСТРОВАЯ ГРАФИКА) 

 
Цель работы изучить инструментарий графического редактора 

растровой графики и способы его настройки в различных режи-

мах. Ознакомиться с плавающими панелями и их назначением. 
Научиться создавать и сохранять различные типы файлов. 

 
Краткие теоретически сведения 

В настоящее время имеется большое количество компью-

терных программ, предназначенных для создания и обработки 
растровой графической информации. Они позволяют выполнять 

обработку фотографий, создавать книжные и журнальные иллю-
страции на высоком профессиональном уровне, поэтому для при-

мера выполнения мы выберем именно его. В основном работает с 

растровой графикой, хотя умеет обрабатывать и векторные изоб-
ражения. Чаще всего такие изображения получают с помощью 

цифровой фотокамеры, при сканировании изображения или путем 
«захвата» кадра видеосъемки. 

 
Растровое изображение представляет собой матрицу раз-

ноцветных точек. Для хранения растровых изображений требует-

ся большой объем памяти. Такие изображения сложно масштаби-
ровать и редактировать. 

Основными параметрами растрового изображения являют-
ся: 

− размер изображения (в дюймах, сантиметрах, точках, пиках 

и т.д.); 
− разрешение (количество пикселей на единицу размера); 

− глубина цвета (количество бит на один пиксель). 
 

Упражнение 1 
Запустите программу. Сразу после запуска вы видите в 

нем только меню, инструменты, палитры и панели. Самого изоб-

ражения нет. Программа не создает пустого документа при от-
крытии, т.к. он предназначен в основном для редактирования су-

ществующих изображений. В левом углу находится панель ин-
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струментов (рис.2.1). С помощью этих кнопок вы будете выде-

лять, перемещать, трансформировать и окрашивать свое изобра-

жение. При нажатии любой кнопки, она становится активной – 
этот элемент выбран. На панели поместились не все кнопки – не-

которые спрятаны.  

                                            
Рис.2.1. Панель инструментов 

 

Создайте новый файл командой меню ФАЙЛ – НОВЫЙ. В 

диалоговом окне укажите параметры, с которыми будет создан 
документ (рис. 2.2). 
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Рис. 2.2. Создание нового файла 

 
Появился новый документ размером 300х300 пикселов с 

разрешением 72 пиксела на дюйм, у которого фоновый слой за-
полнен белым цветом. Работать с документом, не видя его реаль-

ных размеров достаточно сложно, поэтому следует включить 

направляющие линейки (ВИД – НАПРАВЛЯЮЩИЕ или CTRL+R) 
(рис.2.3). 

 

   

 
Рис. 2.3 – Включение направляющих 

В правой части экрана находятся ПАЛИТРЫ (рис. 2.4). Па-

литр всего 13, и они объединены в несколько групп. Если палитры 

нет на экране, ее можно вызвать через меню ОКНО. У каждой па-
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литры есть меню, которое вызывается стрелкой вправо. Чтобы 

палитры не мешали рассматривать изображение, их можно убрать 

клавишами SHIFT + TAB. Эти же клавиши вернут палитры на ме-
сто. 

Обратите внимание на палитру Цвет. Она позволяет уста-
навливать цвет переднего плана и цвет фона. Соответствующий 

цвет можно выбрать, перемещая бегунки R (для красного), G (для 
зеленого), B (для синего цвета). Можно ввести числовое значение 

для каждого цвета или просто щелкнуть пипеткой для взятия 

пробы цвета. 
Для изменения масштаба изображения служит панель 

Навигатор. На этой панели в уменьшенном виде можно просмат-
ривать все изображение. Видимая в окне его часть обозначена 

красной рамкой. Изменять масштаб можно непосредственно вводя 

значение процента, плавно перемещая бегунок, или щелкая по 
кнопкам Уменьшить и Увеличить (рис. 2.5). 

 
 

      
Рис. 2.4. Панель палитра 

 



 

Управление цифровых образовательных технологий 

Мультимедиа технологии 

 

 27 

   

 
Рис. 2.5. Панель навигатор 

 

Для выравнивания объектов по линиям, задания границ 
изображения, проверки вертикальных и горизонтальных линий 

удобно использовать направляющие (сплошные линии синего 
цвета) (рис.2.6). Щелкните мышкой на любой линейке и перета-

щите указатель вниз или вправо. Направляющие можно переме-

щать, используя инструмент «Перемещение». Чтобы случайно не 
сдвинуть направляющие во время работы, их можно закрепить 

(ВИД – ЗАКРЕПИТЬ НАПРАВЛЯЮЩИЕ). Их можно временно спря-
тать ВИД – ПОКАЗАТЬ –НАПРАВЛЯЮЩИЕ, или удалить (ВИД – 

ОЧИСТИТЬ НАПРАВЛЯЮЩИЕ).  
 

 
Рис.2.6. Направляющие 
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Удобно также работать с включенной сеткой: ВИД – 

ПОКАЗАТЬ – СЕТКА. 
Инструмент Кисть обратите внимание на панель свойств 

вверху экрана (рис.2.7). 
 

 
Рис. 2.7. Кисти 

 

Здесь вы можете выбрать другой инструмент, форму ки-

сти, режим, мутность, течение и включить возможности пульве-
ризатора. 

Попробуйте работать с различными формами ки-
сти: жесткая круг-
лая, мягкая круглая, spatter (брызгать), chalk (мел), star(звезда), g
rass (трава), leaves (листья), fuzzball (мокрый мяч), dry 
brush (сухая кисть). Выбирайте различный диаметр и цвет кисти. 

 
Рис. 2.8 – Кисти 

Более детально настроить форму кисти можно, используя 

палитру КИСТИ. 
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Рис. 2.9 – Кисти 

 

Свойство кисти Мутность (правильнее – прозрачность). 
Делает вносимый цвет прозрачным (цвет становится светлее, че-

рез него просвечивает предыдущее изображение). Пока вы не 
отпустили кнопку мыши (один мазок) – закрашивание идет ров-

ным слоем. 
Свойство кисти Течение. Действует подобно мутности. Но 

при этом закрашивается собственный след (т.е. учитывается ди-

намика движения кисти). 
Кнопка включить возможности пульверизатора дей-

ствует, если течение меньше 100% (лучше 10-20%). Удержание 
кнопки мыши на одном месте делает изображение более ярким 

(как если бы вы держали нажатой кнопку пульверизатора). 

Заполните поле рисунка изображениями различного цвета 
и яркости. Теперь попробуйте поменять режим: 

Выберите жесткую круглую кисть 19 пикселей, установите 
цвет средней яркости (например, темно-голубой), и последова-

тельно меняйте режимы, отменяя каждое последнее действие 
(CTRL+Z): 

 

Режим Normal (Нормальный) 
В этом режиме происходит полная замена исходного цвета 

на вносимый. 
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Режим Multiply (Умножение) 

В этом режиме цвета исходный и вносимый "перемножа-

ются", поэтому результирующий цвет получается всегда темнее 
исходного. 

Если вносится черный цвет, то результирующий цвет тоже 
становится черным. Белый цвет на исходный не влияет. 

Режим Screen (Экран) 
В этом режиме цвета исходный и вносимый "делятся", по-

этому результирующий цвет получается всегда светлее исходно-

го. Если вносится белый цвет, результирующий цвет становится 
белым. Черный цвет на исходный не влияет. 

Режим Overlay (Перекрытие) 
В этом режиме затемняются темные цвета, осветляются 

светлые. В результате такого наложения пикселов повышается 

контрастность изображения. 
Режим Soft light (Мягкий свет) 

Этот режим усиливает или ослабляет цвет в зависимости 
от вносимого цвета (результат напоминает освещение рассеян-

ным светом) 
Если вносимый цвет (считайте, что это источник света) 

светлее 50%-го серого, исходный цвет разбеливается (осветляет-

ся) идентично инструменту Dodge (Светлее). 
Если вносимый цвет темнее 50%-го серого, исходный цвет 

усиливается (затемняется) так же, как при работе инструмента 
Burn (Темнее). 

Использование чистого белого или чистого черного цвета 

осветляет или затемняет исходный цвет, но не дает соответ-
ственно белый и черный чистые цвета. 

Режим Hard light (Жесткий свет) 
В этом режиме происходит усиление (затемнение) цвета, 

как в режиме Multiply (Умножение), или ослабление (осветление) 

цвета, как в режиме Screen (Экран), в зависимости от вносимого 
цвета (результат напоминает освещение резким светом). 

Если вносимый цвет (считайте, что это также источник 
света) светлее 50%-го серого, исходный цвет разбеливается 

идентично режиму Screen (Экран). Если вносимый цвет темнее 
50%-го серого, исходный цвет усиливается идентично режиму 

Multiply (Умножение) 

Использование чистого белого или чистого черного цвета 
идентично нормальному режиму. 

Режим очень удобен для создания теневых областей 
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Режим Darken (затемнее цвета) 

В этом режиме происходит замена исходных цветов, а 

именно только тех, которые светлее вносимого, а точки, которые 
темнее вносимого, остаются без изменения 

Режим Lighten (осветление цвета) 
В этом режиме происходит замена исходных цветов, а 

именно только тех, которые темнее вносимого, а точки, которые 
светлее вносимого, остаются без изменения. 

Режим Difference (Разница) 

В этом режиме результирующий цвет равняется разнице в 
яркостях исходного и вносимого цветов. В результате такого 

наложения пикселов создается эффект негативного изображения. 
Режим Hue (Оттенок) 

В этом режиме результирующий цвет получает цветовой 

тон (оттенок) вносимого цвета, но сохраняет значения насыщен-
ности (Saturation) и яркости (Luminosity) исходного цвета. Попро-
буйте закрасить изображение оттенком черного цвета. 

 

Режим Saturation (Насыщение) 
В этом режиме результирующий цвет получает насыщен-

ность вносимого, но сохраняет оттенок (Hue) и яркость 

(Luminosity) исходного. На изображения в градациях серого ника-
кого влияния не оказывает. 

Режим Color (Цвет) 
В этом режиме результирующий цвет получается с ярко-

стью (Lummosily) исходного, но с оттенком (Hue) и насыщенно-
стью (Saturation) вносимого. Это позволяет сохранить серую шка-
лу. Находит широкое применение для цветного тонирования мо-

нохромного изображения. 
Режим Luminosity (Свечение) 

Правильнее – яркость. В этом режиме результирующий 

цвет получается с оттенком (Hue) и насыщенностью (Saturation) 
исходного цвета, но с яркостью вносимого. В серой шкале резуль-

тат совпадает с вносимым тоном. Этот режим по своему результа-
ту противоположен режиму Color (Цвет) 

Режим Dissolve (Растворение) 
Чтобы увидеть действие этого режима, нужно дополни-

тельное условие. Установите в поле Opacity (Мутность) значение 

50%. 
В этом режиме происходит замена исходного цвета на 

вносимый со случайным распределением и учетом прозрачности. 
Результат особенно заметен при больших размерах инструментов 
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Paintbrush (Кисть) или Airbrush (Аэрограф) и частичной мутности. 

 
Задание 1. Объемный шар 

Рисует объемный шар. Теперь, для реалистичности доба-

вим блик на шарик. Фильтр Render\ Lens Flare. Создаем новое 
изображение Файл -Новый (File - New) (в данном случае 100x100 

пикселей). Создаем новый слой (Слой – Новый - Слой (Layer- New 
- Layer)). На этом слое делаем выделение окружностью (инстру-

мент Овальная область (Elliptical Marquee) при нажатой клавише 

Shift) и заливаем любым цветом (инструмент Ведро (Paint 
Bucket)). Выделение после заливки не снимаем. 

Далее используем эффекты свечения на выделении 
Фильтр\ Render\ Lightings Effects. Настройки подбираем по вкусу. 

Отбросим тень от шарика Для чего создадим новый слой (Слой - 

Новый - Слой (Layer – New - Layer)) и поместим его между слоем 
фона и слоем на котором лежит наш шар. Оставшееся выделение 

шара необходимо трансформировать. Выполняем Выделение - 
Преобразовать выделение (Select -Transform Selection) и "сплю-

щиваем" наше выделение, потянув вниз за верхний средний мар-
кер. Выбираем серый цвет и заливаем полученное выделение. 

Смещаем чуть ниже слой, на котором лежит наша тень (использу-

ем инструмент Перемещение (Move)). 
Для придания реалистичности тени ее необходимо раз-

мыть. Перед этим выделение с тени не снимаем. Применяем 
фильтр Blurt Radial blur, устанавливаем опцию Zoom и для Amount 

10. Снимаем выделение Ctrl+D или Убрать выделение (Select - 

Deselect). 
Зададим фон. На нижнем слое выполните градиентную 

заливку по выбору (инструмент Градиент (Gradient) в панели оп-
ций инструмента раскройте список градиентов и щелчком выбе-

рите подходящий, затем на изображении проведите линию указы-

вающую направление цветового перехода). Сводим все слои 
(Слой – Выполнить слияние (Layer – Flatten Image)). Выполнение 

показано на рисунке 2.10. 
 

 
Рис. 2.10. Выполнение задания 1 
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Задание 2. Выделение областей для редактирова-
ния и преобразования изображений 

В этом упражнении нам предстоит вырезать изображение 
цветка из фотографии-оригинала и поместить цветок в новое 

изображение, применив растушевку (сглаживание) краев. 
1. Откройте файл «Кувшинка» (рис.2.11). 

2. Выберите инструмент Масштаб  и растяните 
рамку вокруг цветка, для увеличения картинки. 

3. Теперь выберите инструмент Лассо . 
4. На панели Параметров установите пара-

метр Растушевка равным нулю. 
5. Щелкните на краю цветка и тщательно обведите его 

контур, перетаскивая указатель инструмента Лассо. Постарай-

тесь не отпускать раньше времени кнопку мыши. Если это случит-
ся, вы потеряете часть объекта: выделенная область автоматиче-

ски замкнется по кратчайшей линии. Ну а если такое все же про-
изошло, поместите указатель инструмента внутрь выделенной 

области (возле него появится значок в виде пунктирного прямо-

угольника). Нажмите клавишу Shift и, удерживая ее, продолжайте 
рисовать рамку вдоль контура цвета. 

6. Когда вы приблизитесь к той точке, с которой начали 
рисование рамки, отпустите кнопку мыши. Рамка замкнется, и вы-

деление цветка будет завершено. 
7. Выберите команду меню Редактирование - Копиро-

вать. 

8. Создайте новый файл. В окне диалога автоматически 
будут установлены нужные значения размеров изображения. 

Каждый раз, когда вы копируете или вырезаете выделенную об-
ласть изображения в буфер обмена, а затем создаете новый до-

кумент, его размеры устанавливаются так, чтобы точно вместить 

скопированное изображение. 
9. В окне диалога Имя установите переключа-

тель Прозрачный в разделе Содержимое. Прозрачные области 
изображаются шахматным фоном в окне вновь созданного доку-

мента. 

10. Выберите команду Редактирование - Вставить. На рис. 
2.12 показан результат, полученный после вставки копии изобра-

жения цветка в новый документ. 
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Рис. 2.11. Фотография цветка 

 

 
Рис. 2.12. Копия изображения цветка вставлена в новый документ 
 

Теперь попробуйте применить тот же метод, но на этот 

раз с растушевкой границ выделенной области. 
11. Вернитесь к исходному изображению цветка. 

12. Если ранее построенная выделенная область еще ак-
тивна, щелкните за ее пределами, чтобы отменить выделение. 

13. На панели Параметров введите число 10 в тексто-
вое поле Растушевка. Оставьте флажок Сглаживание установ-

ленным для получения более гладких краев. 

14. Теперь с помощью инструмента Лассо выделите изоб-
ражение цветка так же, как вы делали это в предыдущем упраж-

нении, но, может быть, с несколько меньшей тщательностью. 
15. Скопируйте изображение в буфер обмена. 

16. Создайте новый файл. Установите переключатель 



 

Управление цифровых образовательных технологий 

Мультимедиа технологии 

 

 35 

Белый в разделе Содержимое окна диалога Имя. 

17. Вставьте скопированное изображение. Результат по-

казан на рис. 2.13. 
 

Обратите внимание на мягкие, растушеванные края выде-
ленной области. Этот эффект производит очень приятное впечат-

ление, а достигается без каких бы то ни было дополнительных 
усилий. Попробуйте использовать другие значения радиуса рас-

тушевки. Попробуйте сбросить флажок Сглаживание. Запомни-

те использованную в этом упражнении методику растушевки, она 
пригодится в дальнейшем при создании коллажей. 

 
Рис. 2.13. Выделенная область с растушеванной границей 

 

Задание 3. Замена фона 

1. Перейдите к рисунку с изображением. Постарайтесь 
улучшить качество изображения, воспользовавшись командой 

Изображение → Регулировки → Авто Уровни (<Ctrl>+<Shift>+<L>) 
и окном Кривые Изображение → Регулировки → Кривые 

(<Ctrl>+<M>) 
2. Выделите с помощью инструмента Волшебная палоч-

ка  задний фон изображения. 
3. Теперь необходимо несколько расширить выделение, 

чтобы исключить случайные области. Для этого выполните ко-
манду Выделение → Модифицировать → Расширить. В открывшемся 

окне Выбор расширения установить <Расширить на 2 пикселя> 
4. Не отменяя выделения, перейдите к рисунку с изоб-

ражением пейзажа. Выделите всё изображение командой Выделе-

ние → Всё (<Ctrl>+<A>). 
5. Скопируйте выделенное изображение в буфер обмена 
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командой Редактирование → Копировать (<Ctrl>+<C>). 

6. Вернитесь к рисунку с изображением человека. Не 

снимая выделения выполните команду Редактирование → Вставить В 

(<Ctrl>+<Shift>+<V>). Инструментом Перемещение  выров-
няйте фон так, чтобы он «вписывался» в композицию рисунка. 

7. Объедините слои командой Слой → Выполнить сведе-

ние. 

8. Готовое изображение сохраните в своей папке. 
 

 

Задание 4. Градиентная заливка 
1. Перейдите к рисунку с изображением. Постарайтесь 

улучшить качество изображения, воспользовавшись командой 
Изображение → Регулировки → Авто Уровни 

(<Ctrl>+<Shift>+<L>) и окном Кривые Изображение → Регули-

ровки → Кривые (<Ctrl>+<M>) 
2. Выделите с помощью инструмента Волшебная па-

лочка  задний фон изображения. 
3. Теперь необходимо несколько расширить выделение, 

чтобы исключить случайные области. Для этого выполните ко-

манду Выделение → Модифицировать → Расширить. 

4. В открывшемся окне Выбор расширения установить 
<Расширить на 2 пикселя> 

5. Не отменяя выделения, выберите инструмент Гради-
ент. 

6. Инструментом Цвета переднего плана и фона 
установите цвета переднего плана и фона, выбрав в окне Сбор-

щик цветов составляющие. 

7. На панели инструмента Градиент выберите тип гра-
диента Foreground to Background (от цвета переднего плана к 

фону). 
8. Поэкспериментируйте с различными направлениями и 

типами (Линейный, Радиальный, Угловой, Отражённый, 

Ромбовидный) и видами переходов градиента. 
 

Задание 5. Перевод изображения из чёрно-
белого в цветное 

1. Откройте файл fruits.tif (рис. 2.14) 

2. Поверх слоя с изображением создайте новый слой ко-
мандой Слой → Новый → Слой... (<Ctrl>+<Shift>+<N>) (можно 

воспользоваться кнопкой Создать новый слой, расположенной на 
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палитре Слои). 

3. На палитре Слои в выпадающем списке Установить 
режим смешивания установите режим Цвет. Выберите ин-

струмент Кисть  с твёрдыми краями. Выбирая необхо-
димые цвета инструментом Цвета переднего плана и фо-
на, начните раскрашивать изображение.  

4. Объедините слои командой Слой → Выполнить сведе-
ние. 

 
Рис. 2.14. Перевод изображения из чёрно-белого в цветное 

 
Задание 6. Перевод изображения из цветного 

в чёрно-белого 

1. Откройте любое цветное изображение. 

2. Переведите изображение в чёрно-белый режим ко-

мандой Изображение → Режим → Чёрно-белый. После этого вся 
информация о цвете данного изображения стирается. В результа-

те должна получиться обычная чёрно-белая фотография. 

3. На палитре Слои в выпадающем списке Установить 
режим смешивания установите режим Цвет 

 

 
Задание 7. Слияние картинок 

1 способ 
Обязательное условие – первая и вторая фотографии 

должны быть одинаковыми по размеру (хотя бы по ширине). 

Сделайте активной фотографию1. Перейдите в режим 
быстрой маски, нажав на клавиатуре «горячую клавишу» <Q>. 

Установите цвета фона и переднего плана белый и чёр-
ный. 

Инструментом Градиент, залейте изображение сверху вниз 
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с переходом от цвета переднего плана к цвету фона. Поскольку 

Вы в режиме Быстрой Маски, то белый цвет выглядит прозрач-

ным, а черный красным. Чем краснее, тем прозрачнее будет это 
место на картинке. 

Вернитесь в обычный режим редактирования нажатием 
«горячей клавиши» <Q>.  

Вы получите выделение, большая часть которого будет 
невидимой, так как пиксели выделены частично. 

Сделайте активной вторую фотографию. Выделите всё 

изображение командой Выделение → Всё, или воспользуйтесь 
«горячими» клавишами <Ctrl>+<A>. 

Выделенное изображение поместите в буфер обмена с 
помощью команды Редактирование → Копировать (<Ctrl>+<C>). 

Снова сделайте активной первую фотографию. Вставьте 

изображение командой Редактирование → Вставить В 
(<Ctrl>+<Shift>+<V>). 

Объедините слои командой Слой → Выполнить сведение. 
 

2 способ 
Сделайте активной фотографию 1. 

Выделите изображение любым инструментом выделения, 

например Магнитным Лассо . 
Командой Выделение→Растушевать модифицируйте выде-

ление так, чтобы появилась ещё область частично выделенных 

пикселей. 
На сколько пикселей расширять, укажите сами (например, 

на 60). 

Выделенное изображение поместите в буфер обмена с 
помощью команды Редактирование → Копировать (<Ctrl>+<C>). 

Перейдите ко второй фотографии. Вставьте изображение 
командой Редактирование → Вставить (<Ctrl>+<V>). 

Уменьшите размер слоя изображения 1. 

Объедините слои командой Слой → Выполнить сведение. 
 

 

 
Рис. 2.15. Сведение изображений 
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Контрольные вопросы 

 

1. Кодирование графической информации. Цветовые модели. 
2. Форматы графических файлов. 

3. Понятие мультимедиа и области его применения. 
4. Перечислить достоинства и недостатки различных типов 

графики. 
5. Назвать области применения различных типов график. 

6. Назвать программы и форматы графических изображений. 

7. Дать характеристики цветовым моделям. 
8. Дать определение и характеристику палитрам. 
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ЛАБОРАТОРНАЯ РАБОТА № 3 РАБОТА В ПРОГРАММНОМ 

СРЕДСТВЕ СОЗДАНИЯ МУЛЬТИМЕДИА-ПРОДУКТА 

 
Цель работы изучить инструментарий графического редактора 

и способы его настройки в различных режимах. Научиться созда-
вать, изменять и сохранять различные изображения. 

 

Краткие теоретически сведения 

Работа с контурами 

Контуры (Path) – это единственные векторные объекты в 
Photoshop, научиться работать с ними сложно, но использование 

программы без применения контуров смысла не имеет. 

Рассмотрим инструменты работы с контурами. 

 
Упражнение 1 
Выберем инструмент Pen Tool и нарисуем такую дугу: 

При активном инструменте «перо» с помощью мышки одним 
щелчком поставим точку (Е). На некотором расстоянии левее от 

(Е) поставим еще одну точку (D) и , не отпуская, ведем мышкой 

вверх и немного влево (рис.1). Получается первая часть дуги 
между точками (Е) и (D). Отпускаем мышку. Делаем последний 

щелчок мышкой левее точки (D) (на рисунке это «вторая» точка 
(Е), самая левая), и, не отпуская мышку, придаем правильную 

форму для дуги. Хотя если первую часть дуги вы построили пра-
вильно, то для второй части достаточно одного щелчка. 
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Рис. 3.1. Создание контура 

Теперь дадим определения каждой из составляющих по-
лученной дуги. 

(E), обозначенные «пустыми» точки, и (D) – точки привяз-

ки. 
(B) – управляющая точка. 

(С) – управляющая линия. 
(А) – криволинейный сегмент. 

Линии, созданные инструментом перо, могут быть криво-

линейными и ломаными. 
 

Упражнение 2. Преломленная линия 
Выберем инструмент «перо». Щелчок. Второй щелчок, и, 

не отпуская мышку, придаем закругленность контуру (см. выше). 

При нажатой клавиши ALT щелкаем по точке, созданной в п.2. 
(обратите внимание, как изменился вид курсора при подведении к 

этой точке – внизу появился значок угла). Последний щелчок, и, 
не отпуская, придаем округленность любого направления. Обра-

тите внимание, что отвязаться от контура не так-то просто: нужно 
либо замкнуть контур повторным нажатием на первую поставлен-

ную точку контура, либо сменить инструмент на любой другой из 

панели инструментов (рис. 3.2). 
Очистить рабочую область можно, обратившись к палитре 

History (история). 

 
Рис. 3.2. Преломленная линия 
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Преобразование контура 

Вид кривой, созданной пером, можно изменять. 

 
Упражнение 3 
Нарисуем еще раз кривую (рис.1 правый). Далее, при 

нажатой клавише ALT, щелкаем по средней точке кривой. Курсор 

примет вид черной жирной стрелки и, не отпуская мышку, вид 
кривой можно будет изменить. То же самое – для ломаной линии.  

И еще раз нарисуем кривую. При нажатой клавише CTRL 

(курсор примет вид ) можно менять угол округления, перетас-

кивая управляющие точки (см. точка (В)). Также «перетаскивани-
ем» можно менять расположение точек привязки (точка (Е)). 

Add Anchor Point Tool – «перо+». Нажимая этим инстру-
ментом в любом месте любого сегмента (А), получаем новую точ-

ку. 

Delete Anchor Point Tool – «перо –». Щелкая этим инстру-
ментом по любой из точек контура, удаляем эту точку. 

Convert Point Tool – угол. Изменяет тип опорной точки, то 
есть преобразует гладкую точку в угловую и наоборот (см. рис. 

3.1 правый: средняя точка контура является гладкой, рис. 3.2 - 
средняя точка контура угловая). 

 

Задание 1. Улучшаем карандашные рисунки 
Выполнение показано на рисунке 3.3. 

         
Рис. 3.3. Выполнение задания 1 

 
Первым делом очистите изображение. Для этого удаляем 

цвет, который мог появиться при сканировании.  
Откройте панель «Окно» → «Коррекция». Выберите «Чер-

но-белый» (рис.3.4). 
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Рис. 3.4. Корректирующий слой «Черно-белое» 

 

Удалим грязный фон.  

Добавьте маску слоя в эскиз. Убедитесь, что фоновый 
слой белый, а если нет, добавьте его (см. рис.3.5). 

 

 

 
Рис. 3.5. Добавление маски 

 

Нажмите белый прямоугольник рядом с эскизом эскиза. 

Используйте кисть Soft Round (Быстрое выделение ), чтобы 

нарисовать примерно область вокруг персонажа. Используйте 

масштаб для большей точности. Еще раз применить маску (рис. 
3.6). 
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Рис. 3.6. Добавление маски 

 

Добавим контрастность. Открыть панель «Окно» → «Кор-

рекция». Выберите «Уровни» (рис.3.7). 

 
Рис. 3.7. Корректирующий слой «Уровни» 

 
Эта панель показывает вам гистограмму - распределение 

черных и белых на изображении. Идеальная гистограмма выгля-

дит как гора с пологими склонами, но «совершенная» не означает 
самого желанного. Чем короче (горизонтально) гистограмма, тем 

выше контраст. Перетащите правый ползунок влево, чтобы пре-
вратить светлые серые в белый цвет, а левый ползунок вправо, 

чтобы сделать темные серые черные (см. рис.3.8). 
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Рис. 3.8. Контрастность 

1. Перемещаем части 
Иногда определенная часть рисунка заканчивается там, 

где ее никогда не должно быть. Можете стереть ее, а затем нари-
совать заново, но следы этой "коррекции" останутся. Давайте по-

пробуем другой метод. 

Шаг 1 
Выберите зону, которую вы хотите переместить при по-

мощи инструмента Лассо (Lasso Tool)  
Шаг 2 

Используйте инструмент Перемещение  (Move Tool), 

чтобы перетянуть выделенный участок в правильное место. Сни-
мите выделение, нажав Ctrl + D (см. рис.3.9). 

          
Рис.3.9. Шаг 2 

 
2. Скрываем ошибку 

Мы передвинули участок, но изменение слишком заметно. 

Нужно использовать другой инструмент, который поможет убрать 
погрешность. 
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Шаг 1 

Выберите зону, которую нужно улучшить при помощи ин-

струмента Заплатка (Patch Tool) (Заплатка находится в том же 
меню, что и Точечная восстанавливающая кисть (Spot Healing 

Brush)). 
Шаг 2 

Перетяните выделение в зону, участок которой вы хотите 
"одолжить".  

Шаг 3 

Используйте Заплатку (Patch Tool) везде, где это потребу-
ется, тем самым сделав "шрамы" менее заметными (см. рис.3.10). 

           

 

 
Рис.3.10. Выполнение действия «Скрытия ошибки» 

 

3. Стираем ошибку 
Этот пункт кажется простым, но, используя неправильный 

ластик, мы можем получить поддельный эффект как на рисунке 

3.11. 
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Рис.3.11. Поддельный эффект 

 

Шаг 1 

Чтобы избежать этого, перейдите в меню Окно > Наборы 
параметров для инструментов (Window > Tool Presets). Выберите 

инструмент Ластик  (Eraser Tool), а затем пункт Карандаш с 
ластиком (Pencil Eraser). 

Шаг 2 

Используйте его как обычно. Если вы хотите сделать ла-
стик мягче, не прибегая к помощи графического планшета, изме-

ните его Непрозрачность (Opacity). 

Разница не слишком заметна, но она играет большую роль 
для общего эффекта (см. рис.3.12) 

 

 
Рис.3.12. Выполнение действия «Стираем ошибку» 

4. Изменяем размер участков 

Изменение участка рисунка может быть сложным процес-
сом, так как часто коррекции подвергается большая часть изоб-

ражения. 
Шаг 1 

Дублируйте (Duplicate) слой, нажав Ctrl + J, затем скройте 

его (для этого кликните по иконке глаза слева от миниатюры). 
Выберите участок при помощи инструмента Лассо (Lasso Tool)  

Шаг 2 
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Перейдите в меню Редактирование → Свободное транс-

формание (Edit → Free Transform) или нажмите Ctrl + T. Переклю-

читесь в Режим деформации (Warp Mode) (см. рис.3.13). 
 

 
Рис.3.13. Свободное трансформирование 

 
Шаг 3 

Перетяните маркеры ближе к середине, чтобы уменьшить 

участок или оттяните их к краям, чтобы увеличить. Если что-то 
пошло не так, нажмите Esc и попробуйте снова. 

Шаг 4 
На этом этапе нам также нужно скрыть следы вмешатель-

ства. Мы можем "залатать" шов между измененной зоной и ори-
гиналом, но есть способ проще. Включите видимость слоя-

дубликата, добавьте ему Векторную маску (Layer Mask). Заполни-

те (Fill) ее черным цветом, а затем закрасьте белым только ту 
часть, которая находится правее от шва. 

5. Изменяем форму участка 
Тот же инструмент можно использовать для изменения 

формы участка (см. рис.3.14) 
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Рис.3.14. Шаги 1-4 

 
Если вам необходимо больше контроля, попробуйте дру-

гой, гораздо более мощный инструмент: 
Шаг 1 

Перейдите в меню Фильтр → Пластика (Filter → Liquify) 

или используйте клавиатурное сокращение Ctrl + Shift + X. 
Шаг 2 
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Используйте инструмент Деформация (Forward Warp Tool), 

изменив форму некоторых участков. Чем крупнее кисть, тем нату-

ральнее эффект. Будьте осторожны: в этом режиме можно отме-
нить только одно действие! 

Примечание переводчика – на самом деле, в фильтре 
Пластика работают те же быстрые клавиши, что и в основном 

окне. Используйте Ctrl + Alt + Z для отмены действия, а Ctrl + 
Shift + Z для возвращения изменений (см. рис.3.16). 

 

 
Рис.3.16. Пластика изображения 

 

6. Добавляем тени 
В предыдущих шагах мы корректировали форму нашего 

персонажа. Теперь мы попробуем сделать несколько более слож-

ных правок – добавим кое-что к рисунку. Однако, чем больше вы 
используете подобные коррекции, тем очевиднее становится ком-

пьютерное вмешательство, но иногда эффект того стоит. 
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Шаг 1 

Дублируйте слой (Ctrl + J) и работайте с копией, оставив 

оригинал под ней. Перейдите в Режим быстрой маски (Quick Mask 
Mode) (Q). Выберите мягкую кисть и пометьте зоны, которые хо-

тите затемнить. 
Шаг 2 

Выйдите из Режима быстрой маски (Quick Mask 
Mode). Инвертируйте (Invert) выделение, нажав Ctrl + Shift + I. 

Перейдите в меню Изображение → Коррекция → Цветовой 

тон/насыщенность (Image → Adjustment → Hue/Saturation). Со-
кратите значение параметра Яркость (Lightness) (см. рис.3.17). 

  

 
Рис.3.17. Корректировка яркости 

 

Шаг 3 
Используйте тот же ластик, чтобы стереть тень вокруг те-
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ла. 

Шаг 4 

Теперь используйте этот ластик для "смешивания" тени. 
Она не должна быть такой равномерной; сделайте ее немного 

"рваной" (см. рис.3.18). 

 
Рис.3.18. Шаги 3-4 

 
Как видите, это очень радикальная коррекция, поэтому не 

переусердствуйте. Чем меньше будет финальный рисунок, тем 

труднее будет заметить вмешательство. 
 

7. Добавляем блики 
Это эффект будет работать, только если объект был нари-

сован в темных тонах. В моем случае, мне нужно затемнить весь 

рисунок. Создайте Новыйслой (New Layer), нажав Ctr + Alt + Shift 
+ N и заполните его черным цветом при помощи инструмента За-

ливка (Paint Bucket Tool). Сократите Непрозрачность (Opacity) это-
го слоя. 

Шаг 2 
Перейдите в Режим быстрой маски (Quick Mask Mode) (Q) 
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и при помощи мягкой кисти пометьте зоны, которые должны бле-

стеть. 

Шаг 3 
Выйдите из Режима быстрой маски (Quick Mask Mode). Ин-

вертируйте (Invert) выделение, нажав Ctrl + Shift + I. Кликните на 
основной слой и Дублируйте (Duplicate) выделенную зону при по-

мощи клавиатурного сокращения Ctrl + J. Перетяните слой-копию, 
разместив его над слоем с затемнением (см. рис.3.19). 

 
Рис.3.19. Слой с затемнением 

 
Шаг 4 

Используйте те же техники, применяемые для работы с 
тенями, чтобы "смешать" блики (см. рис.3.20). 

 
Рис.3.20. Смешивание бликов 

 
Шаг 5 

Сократите Непрозрачность (Opacity) для получения более 
мягкого эффекта. 

 

8. Добавляем размытие 
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Внимание: этот эффект выглядит очень "по-цифровому". 

После его применения сразу будет видно компьютерное вмеша-

тельство в работу! 
Шаг 1 

Перейдите в Режим быстрой маски (Quick Mask Mode) (Q) 
и при помощи мягкой кисти нарисуйте обводку вокруг объекта 

(см. рис.3.21). 

 
Рис.3.21. Обводка вокруг объекта 

Шаг 2 

Выйдите из режима (Q), инвертируйте выделение (Ctrl + 
Shift + I). Перейдите в меню Фильтр → Размытие → Размытие по 

Гауссу (Filter → Blur → Gaussian Blur) (см. рис.3.22). 

 

 
Рис.3.22. Размытие по Гауссу 

 
Будьте осторожны - на этом этапе легко перестараться!  

 
9. Делаем рисунок резче 

Чтобы сделать линии чище, даже если они были очень 
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размыты в оригинальном изображении, мы перейдем в ме-

ню Фильтр → Усиление резкости → "Умная" резкость (Filter → 

Sharpen → Smart Sharpen) (см. рис.3.23). 
 

 
Рис.3.23. "Умная" резкость 

 
10. Добавляем "бумажный" эффект 

Шаг 1 

Это самый популярный и самый "невинный" трюк для 
улучшения рисунков. Разместите текстуру бумаги над изображе-

нием. Измените Режим наложения (Blend Mode) слоя с бумагой 
на Умножение (Multiply). 

Шаг 2 

Кликните правой кнопкой мыши по слоям и выберите 
Объединить слои (Flatten Image). Затем перейдите в меню Фильтр 
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→ Галерея фильтров (Filter → Filter Gallery). Выберите фильтр и 

Текстуризатор(Texturizer), находящийся в папке Текстуры 

(Textures). Настройте параметры по своему усмотрению. 
Шаг 3 

Последний, но важный пункт - вы можете воспользоваться 
Уровнями (Levels) (Ctrl + L), отрегулировав яркость всего изобра-

жения (см. рис.3.24). 
 

 
Рис.3.24. Финальная работа 

 

Задание 2. Создание озера 
Средствами графического редактора можно не только 

преобразовывать, ретушировать и создавать изображения, но и 
коренным образом изменять их, внося свои идеи и настроения. 

Допустим, нам бы хотелось видеть вместо тропы озеро, 

самое настоящее, с настоящим отражением. Вы можете подобрать 
для этой цели любой пейзаж (или не пейзаж). 

 
Первым делом надо обвести контур будущего водоема. 

Для этого можно использовать любые средства построения масок 
или выделения части изображения. Самый простой вариант, ко-

торым и воспользуюсь, – применить инструмент «лассо», активи-

зируемый клавишей [L] или выбираемый мышкой из палитры ин-
струментов. Удерживая нажатой левую кнопку мышки, провожу 

линию берега. Когда область выделена и ее форма отвечает 
творческому плану, создаем новый слой, щелкая мышкой по 

кнопке в палитре слоев. Новый слой Layer 1, на котором пока ни-

чего нет, сразу становится активным, то есть рабочим, но рисо-
вать на нем можно лишь в пределах, ограниченных созданным 

шаг назад выделением. 
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Теперь надо выбрать цвета для тонирования воды. Пипет-

кой с фотоснимка снимаем один из самых темных оттенков буду-

щего отражения. Это будет передний цвет. В качестве цвета фона 
выбираем один из наиболее светлых цветов. Теперь воспользуем-

ся растяжкой, или градиентной заливкой, чтобы окрасить выде-
ленную область на слое Layer 1 снизу-вверх от темного к светло-

му. С помощью растяжки мы задали изменение коэффициента 
отражения поверхностью воды. Чтобы сымитировать рябь, при-

бегнем к фильтру Add Noise, вызываемому через меню Filter/Noise. 

Распределение шума должно быть равномерным, то есть Uniform, 
а его количество надо подбирать, исходя из размеров картинки и 

творческого замысла. Рекомендую 15-20 (на «вкус»). Снимаем 
выделение (CTRL+D). Начинаем строить отражение. Для этого 

надо скопировать фотоснимок на новый слой. Выбрав в палитре 

слоев Background, перетягиваем его мышкой на кнопку создания 
нового слоя, расположенную в низу палитры Layers. Слой под 

названием Background copy появился между слоями Background и 
Layer 1. Отражение надо переместить на самый верх, поэтому пе-

ретягиваем его в палитре слоев и отпускаю над Layer 1 (см. 
рис.3.25). 
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Рис.3.25. Преобразование изображения 
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Собственно, отражение. При активном слое Background 

copy вызываем Edit → Transform → Flip Horisontal. Эта команда 

зеркально отражает слой в горизонтальном направлении, что нам 
и требуется. Не спутайте ее только с командой Flip Horisontal из 

меню Image/Rotate Canvas, которая переворачивает всю компози-
цию – «холст», включая все слои. Если бы мы не строили такое 

«косое» отражение, а выбрали бы объект, отражающийся прямо 
перед собой, нам было бы достаточно предыдущего шага (только 

используя Flip Vertical ). Однако слишком много «бы». Короче, мы 

пошли другим путем, и поэтому потребуется снова вернуться к 
команде Edit → Transform и выбрать Rotate, чтобы завершить 

«переворачивание» изображения. Появится вот такая прямо-
угольная рамка, вращать которую можно за ее угловые точки. 

После того, как угол будет верным, не забудьте нажать Enter (тем 

самым согласившись с изменениями). Отражение слой Background 
copy, надо смесить на «юго-восток». Можно воспользоваться кла-

вишами вверх/вниз/вперед/назад при активном инструменте пе-
ремещения для более точной регулировки расположения отраже-

ния. Целиться пока трудно, да и не надо, так как позже положе-
ние отражения можно будет подправить очень точно и, главное, 

наглядно. Из слоев Layer 1 и Background copy организуем срезае-

мую группу. Для этого надо, удерживая нажатой клавишу [Alt], 
щелкнуть мышкой по линии, разделяющей эти слои в палитре 

Layers. В момент, когда можно щелкать, курсор примет форму 
двух кружков со стрелкой посередине. 

Сейчас можно, воспользовавшись инструментом переме-

щения, подправить сдвиг отражения до максимально реалистич-
ного. Для наложения пикселов надо переключить в палитре слоев 

для слоя Background copy режим с Normal на Multiply. Режим 
Multiply задает «умножение» цветов, при котором результирую-

щий цвет всегда будет темнее исходного, то есть взятого с ниж-

него слоя. Если вам покажется, что отражение вышло слишком 
темным, можно затемнить его другим способом: обычным инстру-

ментом, отрегулировав предварительно Opacity. Объединим слои 
Background copy и Layer 1 командой Merge Down. Ее можно вы-

звать из меню Layer, из меню палитры Layers или просто клави-
шами [Ctrl]+[Е]. В природе отражение столь правильным не бы-

вает. «Размоем» его фильтром Motion Blur (меню Filters→Blur). 

Параметры: угол 0 градусов, дистанция – 4 пикселя. Для про-
зрачной воды требуется добавление прозрачности. В палитре 

слоев для Layer 1, на котором у нас сосредоточена вся вода, из-
меняем Opacity до 85-90%. И последнее. У нас же осеннее 
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настроение:) Для большей реалистичности просто необходим 

фильтр Diffuse Glow из меню Filters → Distort. Он добавит немного 

осеннего «мусора» на воде. Параметры на рисунке 3.26. 

  

 

 
Рис.3.26. Финальная работа 
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Задание 3. Смарт-объекты 

Уделим внимание работе со Смарт-объектами (Smart 

Object).  
Шаг 1 

Выберите фото и откройте изображение. 
Шаг 2 

Преобразуем фотографию в смарт-объект. В настройках 
моей версии програмы, все новые объекты автоматически добав-

ляются как смарт-объекты. Если ваша программа настроена ина-

че, то нет никакой проблемы в том, чтобы преобразовать слой в 
смарт-объект. Для этого, просто щелкните правой кнопкой мыши 

на слое и выберите Преобразовать в смарт-объект (Convert to 
Smart Object). 

Как видите, визуально не произошло никаких изменений. 

Но в правом нижнем углу иконки слоя, появился маленький зна-
чок смарт-объекта, а также, слой был автоматически переимено-

ван из «Background» в «Layer 0» (см. рис.3.27). 
 

 
Рис.3.27. Преобразование в смарт-объект 

 

Шаг 3 
Дублируйте слой «Layer 0». Для того, чтобы быстро со-

здать копию слоя, нажмите комбинацию клавиш Ctrl+J. Теперь у 

вас есть два слоя, которые представляют собой смарт-объекты. 
Шаг 4 

Встаньте на слой-копию. Активируйте инструмент Прямо-
угольная область (Rectangular Marquee tool (M)). Создайте на фо-

то квадратное выделение в правом верхнем углу. Не снимая вы-

деление, нажмите на иконку «Добавить слой-маску» («Add layer 
mask») (см. рис.3.28). 
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Рис.3.28. Шаг 4 

Шаг 5 

Теперь, давайте немного видоизменим слой, к которому 
мы применили слой-маску. 

Прежде всего, сделайте щелчок по миниатюре слоя, для 
того что бы сделать его активным. Затем нажмите на значок 

«скрепка», который находится между миниатюрой слоя и слой-

маской. Это действие отключит связь между слоем и его маской. 
Как результат: мы можем передвигать само изображение, а при 

этом слой-маска останется статичной. 
Давайте проверим это на упражнении. Активируйте функ-

цию Свободное трансформирование (Free Transform) (Редактиро-

вание → Свободное трансформирование). 
Нажмите и удерживайте клавишу Shift, и перетащите одну 

из угловых точек внутрь, чтобы уменьшить размер фотографии. 
Откорректируйте размер фотографии так, чтобы определенный 

объект полностью разместился в квадрате. Нажмите клавишу 
Enter для того что бы применить внесенные изменения (см. 

рис.3.29). 
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Рис.3.29. Свободное трансформирование 

 
Повторим шаги 3-5 еще два раза и поместим дубликаты 

равномерно вдоль правой стороны. Рассмотрим эти действия по-

дробнее: 
Дублируйте оригинальный слой смарт-объект (Ctrl+J). 

Создайте квадратную выделенную область. Добавьте к 
новому слою-копии слой маску (Add layer mask). 

При размещении квадратов ориентируйтесь на первый 

квадрат. Размещайте новые области как показано ниже на кар-
тинке. 

Используйте Свободную трансформацию (Free Transform), 
для того, чтобы изменить фото и разместить в квадрате необхо-

димый участок изображения. 
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Шаг 7 

Добавим акценты. Для этого, мы будем использо-

вать Стили слоя (Layer Styles). Для того, чтобы перейти к меню 
Стиль слоя (Layer Styles), сделайте двойной щелчок по одному из 

слоев со снимком (кроме слоя «Layer 0»). В данном примере мы 
воспользуемся такими стилями как: Тень (Drop 

Shadow), Внутреннее свечение (Inner Glow) и Обводка (Stroke). На 
изображениях ниже, вы можете рассмотреть настройки, которые 

я применила (см. рис.3.30). 
 

 

 
Рис.3.30. Добавим акценты 

 

К остальным двум квадратам, мы так же добавим стили 
слоя, которые применили ранее. Для того, чтобы быстро скопиро-

вать уже имеющийся стиль слоя вам нужно, зажать клавишу Alt, и 
не отпуская ее, нажмите на значок-иконку стиля слоя «fx». Пере-

тащите данный значок на те слои, к которым нужно доба-
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вить стиль слоя. 

Шаг 9 

Встаньте на слой «Layer 0». Затем нажмите на соответ-
ствующую иконку в нижней части панели для того, чтобы доба-

вить корректирующий слой Уровни. Используя ползунки, сделайте 
основное фото немного светлее (см. рис.3.31).  

 
Рис.3.31. Корректирующий слой Уровни 

 
Шаг 10 

Так же, к слою «Layer 0», мы добавим Фильтр → Размытие 

→ Размытие по Гауссу (Filter → Blur→Gaussian Blur). Радиус раз-
мытия установите на 3 пикс. Обращаю ваше внимание на то, что 

благодаря тому, что мы работаем со смарт-объектом, мы всегда 
можем дополнительно подкорректировать воздействие фильтра 

на основное изображение. Если вы посмотрите на панель слоев, 

то увидите, что ваш фильтр отображается как смарт-фильтр под 
соответствующим слоем «Layer 0» (см. рис.3.32). 
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Рис.3.32 Размытие 

 

Шаг 11 
Добавим финальные элементы. Активируйте инструмент 

Прямоугольник (Rectangle tool), горячая клавиша для данного ин-

струмента - «U». Затем нажмите на клавиатуре клавишу «D», а 
после «Х». Такая последовательность поможет вам установить 

цвет переднего и заднего плана на черный и белый, а затем уста-
новить цвет переднего плана на белый. На новом слое нарисуйте 

большой прямоугольник белого цвета (под корректирующим сло-

ем «Уровни»). 
Сделайте двойной щелчок по слою с прямоугольником, 

для перехода к меню Стиль слоя (Layer Styles). Перейдите к Об-
водка (Stroke). Размер обводки установите на 2 пикс., цвет обвод-

ки — черный. Нажмите кнопку ОК, чтобы добавить стиль и за-
крыть диалоговое окно Стиль слоя (Layer Style). Заливку (Fill) слоя 

с белым прямоугольником, нужно понизить до 30% (см. рис.3.33). 
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Рис.3.33. Добавим финальные элементы 

 
Шаг 13 

Украсим прямоугольник текстом. Для этого, на панели ин-

струментов, активируйте Горизонтальный текст (Type tool (T)). 
Выберите любой понравившийся вам вид и размер шрифта и 

напишите надпись или пожелание. Для корректировки между-
строчного пространства и прочих настроек шрифта, рекомендую 

вам использовать Окно → Символы (Window → Character). 

Шаг 14 



 

Управление цифровых образовательных технологий 

Мультимедиа технологии 

 

 68 

Сохраните вашу работу в PSD формате. Можете дать 

название данному файлу «шаблон». Благодаря тому, что мы ра-

ботали со смарт-объектами, любой элемент полученного шаблона 
можно быстро заменить на другой. 

Это очень удобно. Теперь, если у нас есть несколько фото 
к которым мы хотим применить похожий эффект, нам не нужно 

проделывать все заново — достаточно перейти к смарт-объекту 
из шаблона и заменить его на новое изображение. Для этого, 

сделайте щелчок по слою правой клавишей мыши и в подменю 

найдите пункт «Заменить содержимое» (Smart Objects→Replace 
Contents). 

 

Контрольные вопросы  
 

1. Кодирование графической информации. Цветовые модели. 
2. Форматы графических файлов. 

3. Понятие мультимедиа и области его применения. 

4. Перечислить достоинства и недостатки различных типов 
графики. 

5. Назвать области применения различных типов график. 
6. Назвать программы и форматы графических изображений. 

7. Дать характеристики цветовым моделям. 

8. Дать определение и характеристику палитрам. 
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ЛАБОРАТОРНАЯ РАБОТА № 4 СОЗДАНИЕ АНИМАЦИИ, 

ЭЛЕМЕНТОВ УПРАВЛЕНИЯ ДЛЯ МУЛЬТИМЕДИА-ПРОДУКТА 

И ИЗУЧЕНИЕ ОСНОВ ПРОГРАММИРОВАНИЯ МУЛЬТИМЕДИА 

ПРИЛОЖЕНИЙ 

 

Цель работы изучить методы создания анимации, методы со-
здания интерактивных приложений и основы программирования 

мультимедиа приложений. 
 

Краткие теоретически сведения 

Программное средство позволяет анимировать объекты, 
то есть отображать процесс их перемещения и/или изменения 

формы, размера, цвета, прозрачности и угла поворота. Изменения 
могут происходить независимо друг от друга и одновременно с 

изменениями в других слоях. Анимация создается путем измене-
ния содержания последовательно расположенных кадров. 

Существуют два типа программной анимации:  

1. пошаговая или покадровая (frame-by-frame)  
2.  автоматическая или кадрированная (tweened).  

Для пошаговой анимации каждый кадр необходимо нари-
совать отдельно, для кадрированной – первый и последний кад-

ры, а содержание промежуточных рассчитается автоматически. 

Покадровая анимация увеличивает размер файла намного боль-
ше, чем автоматическая анимация, но позволяет более точно 

управлять движением. 
Рисование осуществляется в ключевом кадре, в котором 

создатель фильма выполняет смену анимированного изображе-
ния. В автоматической анимации ключевые кадры перемежаются 

с промежуточными, которые создаются автоматически путем ин-

терполяции информации в ключевых кадрах. 
Различают 2 вида автоматической анимации: 

− движение (Motion-tweening) – предназначен для 
управления атрибутами объекта. Наиболее типичное примене-

ние – изменение координат или ориентации;  

− превращение (Shape-tweening) – предназначен для 
преобразования формы одного объекта в другой. Следует заме-

тить, что метод работает только с объектами типа «рисунок». 
Объекты типа «текст» и «символ» можно преобразовать в рису-

нок, используя Modify→Break Apart. 
Управление кадрами осуществляется в панели Timeline 

(временная диаграмма). Для ее открытия выберите пункт меню 
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Window→Timeline. 

 

Использование контрольных точек при анимирован-
ном изменении формы 

Использование контрольных точек позволяет управлять 
более сложными процессами по изменению формы объекта. Кон-

трольные точки идентифицируют участки, которые должны соот-
ветствовать в начальных и конечных формах объекта. Например, 

если попытаться сделать анимированное изменение выражения 

рисунка лица, можно использовать контрольные точки и отметить 
каждый глаз (рис. 4.1). Тогда, вместо превращения лица в 

аморфную путаницу в процессе анимации, каждый глаз остается 
на своем месте, и будет изменяться отдельно от остальных участ-

ков рисунка.  

 
Рис. 4.1. Анимация маски и контрольные точки 

 
Контрольные точки для идентификации отмечены буквами 

от a до z, которые соответствуют друг другу начальному и конеч-
ному ключевому кадру. Максимальное число контрольных точек 

26.  

Контрольные точки отображаются желтым в стартовом 
кадре, и зеленым в последнем. Если же они расположены некор-

ректно – отображаются красным цветом.  
Для достижения наилучших результатов анимированного 

изменения формы, следуйте следующим рекомендациями.  
– При преобразовании одной сложной формы в другую, 

создайте промежуточные формы и осуществите преобразование 

не сразу из начальной формы в конечную, а из начальной в про-
межуточную (потом в другую промежуточную и т.д.), и уже из 

промежуточной в конечную.  
– Соблюдайте последовательность контрольных точек в 
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ключевых кадрах, например, если имеются 3 контрольных точки в 

одной строке, они должны быть расположены в том же самом по-

рядке во всех ключевых кадрах анимации с изменением формы.  
– Контрольные точки желательно разместить по очереди 

против часовой стрелки, начиная с левого верхнего угла объекта. 
 

Задание контрольных точек 
1. Для добавления контрольных точек необходимо создать 

Shape-анимацию.  Выберите первый ключевой кадр в анимиро-

ванной последовательности. Не забудьте задать в панели 
Properties параметр Tween: Shape в начальном и конечном 

кадре.  
2. На начальном кадре выберите из меню Modi-

fy→Shape→Add Shape Hint. Контрольные точки появляются как 

красные круги с буквой недалеко от центра анимируемого объек-
та. 

3. Передвиньте контрольные точки в нужную вам область 
объекта на линиях. 

4. Выберите последний ключевой кадр в анимированной 
последовательности. Передвиньте контрольные точки в ту об-

ласть объекта, которая должна соответствовать контрольной точ-

ке с аналогичной буквой из первого ключевого кадра. В послед-
нем ключевом кадре контрольные точки станут иметь вид зелено-

го круга с буквой. 
5. При возвращении на начальный кадр контрольные точ-

ки станут иметь желтого цвета. 

6. Протестируйте свой ролик и обратите внимание, как 
именно контрольные точки изменяют процесс анимации. При 

необходимости переместите контрольные точки для достижения 
наилучших результатов.  

7. Чтобы видеть контрольные точки, выберите из меню 

View→Show Shape Hints. Для отображения контрольных точек, 
ключевой кадр и слой которые их содержат должны быть выде-

ленными в Timeline.  
8. Чтобы удалить контрольную точку, перетащите ее за 

пределы рабочей области или используйте лекальное меню на 
контрольной точке.  

9. Помните. Созданные вами анимированные объекты не 

должны быть символами. Функция Options →Object Drawing 
должна быть выключена. 

 
Кнопка 
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Кнопка – это особый тип символа со специальной вре-

менной диаграммой. Кнопки обеспечивают интерактивность 

фильма. Кнопки фактически являются интерактивными фрагмен-
тами фильма. Когда вы выбираете для создаваемого символа тип 

Button (Кнопка), Flash создает временную диаграмму с четырьмя 
кадрами (рис. 4.2).  

 

 
Рис. 4.2. Временная диаграмма символа кнопки 

 

Каждый кадр во временной диаграмме символа кнопки 

имеет определенную функцию: 
– первый кадр – состояние Up – вид кнопки, когда указа-

тель мыши на нее не наведен;  
– второй кадр – состояние Over – вид кнопки при наведе-

нии на нее указателя мыши;  

– третий кадр – состояние Down –  вид кнопки при нажа-
той на ней кнопке мыши;  

– четвертый кадр – состояние Hit – определяет область, 
чувствительную к действиям указателя. Эта область при воспро-

изведении фильма невидима.  
Временная диаграмма кнопки фактически не воспроизво-

дится, а просто реагирует на движение указателя и действия 

пользователя, воспроизводя соответствующий кадр. 
Фигура, расположенная в рабочей области, представляет 

собой экземпляр символа кнопки, с помощью которого мы будем 
создавать изображения для различных состояний. 

Чтобы сделать кнопку интерактивной в фильме размести-

те экземпляр символа кнопки на сцене и назначьте ей действия. 
Действия должны быть назначены именно экземпляру кнопки в 

фильме, а не кадрам ее временной диаграммы. 
Любой экземпляр кнопки в рабочей области можно 
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настроить на выполнение конкретного действия. Для этого выде-

лите экземпляр кнопки и на вкладке Actions выберите необходи-

мые команды и их параметры. 
 

Упражнение 1. Уроки анимации 
Выполните уроки, описанные в файле Анимация.fla. 

 
Задание 1. Изучение покадровой анимации 

Рассмотрим метод Покадровой анимации на примере па-

дающего шара и его восстановления. 
1. Создаем новый файл. 

2. Задаем параметры документа (рис. 4.3). Установим 
размер документа: 400×300 пикселей. 

   

 
Рис. 4.3. Параметры документа 

 

3. Установите такой масштаб отображения документа, 
чтобы Стол целиком отображался в рабочей области. 

4. В верхней части стола создайте изображение шара 
без контура (рис. 4.4). При этом первый кадр на временной диа-

грамме будет помечен как ключевой (черной точкой). 
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Рис. 4.4. Задание шара без контура 

 

5. Правой кнопкой мыши щелкните в ячейке второго 
кадра и в контекстном меню выберите команду Insert Keyframe 

(Вставить ключевой кадр). На Монтажном столе появится 
второй кадр фильма. 

 
Рис. 4.5. Вставить ключевой кадр 

6. Теперь переместите изображение шара в нижнюю 
часть стола. Создайте третий ключевой кадр, на котором будет 

показано, как от шара откололся кусочек. 

7. На четвёртом ключевом кадре от шара должен отко-
лоться ещё один кусочек. 

8. На пятом ключевом кадре должно остаться нечто, в 
предыдущей жизни бывшее шариком. Параметры документа 

изменить частоту кадров на 5 кадров в секунду (рис.4.6). 
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Рис. 4.6. Выполнение задания 

9. Просмотрим готовый фильм, нажав сочетание клавиш 

<Ctrl>+<Enter>. 
10. Теперь восстановим шар. На монтажном столе выде-

лите все кадры фильма и используя контекстное меню, выполните 

команду Reverse Frames (Перевернуть кадры). Просмотрим 
получившийся результат. 

 
Задание 2. Изучение метода анимации Shape 

Tweening 
 

Рассмотрим метод Shape Tweening на примере преобра-

зования круга в квадрат. 
1. Для начала с помощью инструмента Oval  нарисуйте 

круг.  
2. Включите инструмент Selection и на линейке Timeline 

выделите позицию под цифрой 30. Теперь выберите в меню In-

sert→Timeline→Keyframe (F6). Этим действием вы сделали 30-
ый кадр будущего ролика ключевым. Обратите внимание, что ли-

нейка между кадрами стала серой. 
3. В 30-м кадре с помощью инструмента Rectangle нари-

суйте справа от окружности квадрат, а окружность выделите и 
удалите. 

4. Дважды щелкните мышкой на серой области линейки 

между 1-ым и 30-ым кадром и на панели Properties выберите 
анимацию Tween: Shape. 

5. Запустите анимацию, выделив первый кадр и нажав 
клавишу Enter. Для того чтобы получить окончательный ролик, 

следует обсчитать его через пункт меню Control→Test Movie 

(Ctrl+Enter). Сравните результат с примером example1 
(рис.4.7). 
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Рис. 4.7 – Преобразование окружности в квадрат 

 
Задание 3. Изучение метода анимации Motion 

Tweening 
1. Создайте новый документ и нарисуйте окружность. По-

ле залейте с помощью инструмента Paint Bucket  черно-белым 

радиальным градиентом. 
2. Выделите объект Edit→Select All и в меню выберите 

Modify→Convert to Symbol. В поле Name задайте название 
объекта: ball, а в поле Behavior задайте тип объекта: Graphic. 

3. Не снимая выделения, в панели Window→Design 

Panels→Info установите параметры  x=150, y=50, w=50, 
h=50. 

4. Сделайте 61-й кадр ключевым. 
5. Дважды щелкните мышкой на серой области линейки 

между первым и последним кадром (для выделения всех кадров) и 
в панели Properties выберите параметр Tween: Motion. 

6. Сделайте 31-ый кадр ключевым. 

7. Выделите мышкой объект в этом кадре и установите в 
панели Info координату y=250. Запустите анимацию, поставив 

курсор в первый кадр и нажав клавишу Enter. Шарик совершает 
движение от верхней точки к нижней и обратно. 

8. Для полноты иллюзии прыгающего мяча сделайте клю-

чевыми кадры 28 и 34, после чего в кадре 31 выделите мяч и со-
жмите его по вертикали с помощью палитры Window→Design 

Panels→Transform, сняв галочку Constrain и установив пара-
метр h на 10-20% меньше установленного.  

Для увеличения реалистичности можно добавить эффект 

ускорения, управляя параметром Ease в панели Properties для 
отрезков между ключевыми кадрами. Положительное число обес-

печивает торможение, а отрицательное – ускорение.  
Сравните полученный результат с примером example2.  

 
ЗАДАНИЕ 4. ПРЕОБРАЗОВАНИЕ КРУГА В КВАДРАТ 

Создайте три анимации, некоторые кадры из которых 
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представлены на рисунках 10-12. При необходимости используйте 

контрольные точки (рис.4.8-4.10). 

 

 
Задание 5. Движение по пути 

1. Упражнение 5 выполняется как продолжение упражне-

ния 3. Задайте длительность анимации, активизировав 181-й кадр 
и сделав его ключевым.  

2. Создайте новый слой Insert→Timeline→Layer, акти-
визируйте мышкой его первый кадр и в нижней части рабочего 

поля нарисуйте во всю ширину с помощью инструмента Pencil 

линию, имитирующую пологую поверхность земли. 
3. Используйте созданную линию в качестве пути для пры-

гающего мяча. Выделите линию, щелкнув на ней мышкой, и ско-
пируйте ее в буфер Edit→Copy. Теперь для слоя с ball_clip (у 

нас Layer 1) создадим слой с путем. Для этого выделите мышкой 

слой Layer 1 и выберите в меню Insert→Timeline→Motion 
Guide. Первый кадр слоя Layer 1 выделите мышкой и вставьте в 

слой содержимое буфера Edit→Paste in Place. Устано-
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вите в панели Info координату y меньше на 220 от имевшейся. 

4. Для того чтобы заставить мяч двигаться по созданной 

траектории, следует в первом и последнем кадре анимации «по-
садить» мяч на путь. Чтобы получить корректный результат, точ-

но следуйте дальнейшим инструкциям.  
5. Активизируйте первый кадр на Timeline в слое Layer 

1. 
6. Задайте в Layer 1 между первым и последним кадром 

Motion Tweening и установите в панели Properties опцию 

Snap. 
7. Теперь достаточно в первом кадре подтянуть центр 

объекта ball_clip к пути, чтобы мяч сам запрыгнул на линию, об-
разующую траекторию его движения. Проделайте то же в по-

следнем кадре. Для того чтобы убедиться, что мяч принял за тра-

екторию движения наш путь, воспользуйтесь режимом Onion 
Skin или Onion Skin Outlines. Нажмите кнопку под Timeline, 

как показано на рис. 4.11, и раздвиньте маркеры на счетчике 
кадров на всю длину ролика. Данные режимы предназначены для 

отображения поведения объекта во времени. 
 

 
Рис. 4.11 Режим Onion Skin 

 
8. Обсчитайте ролик (Ctrl+Enter) и сравните его с приме-

ром example4. Если вы все сделано правильно, то теперь у вас 

имеется кинематическая модель движения мяча. 
 

Создание анимированного символа 
1. Создайте из готовой анимации ролик Movie clip. Для 

этого следует при нажатой клавише Shift выделить на панели 
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Timeline сначала первый, а потом последний кадр анимации и 

скопировать кадры через Edit→Timeline→Copy Frames.  

2. Откройте новый документ File→New и создайте символ 
Insert→New Symbol. В раскрывшемся окне установите радиок-

нопку в позицию Movie Clip и задайте в поле Name уникальное 
имя ball_clip.  

3. Теперь поставьте курсор в первый кадр панели 
Timeline созданного Movie Clip и вставьте ранее скопированные 

кадры через пункт меню Edit→Timeline→Paste Frames. Верни-

тесь в сцену, щелкнув в левом верхнем углу под меню кнопку 
Scene 1. 

4. Вызовите палитру Library, выбрав в меню 
Window→Library. Важно понять, что анимация прыгающего мя-

ча теперь находится в символе ball_clip, и мы можем пользоваться 

ею как объектом. Перетащите мышкой из библиотеки в середину 
рабочего поля символ ball_clip и нажмите Ctrl+Enter для обсче-

та ролика. Обратите внимание, что результат использования ани-
мированного символа можно просмотреть только после обсчета 

ролика. При просмотре через Enter вы увидите вместо анимиро-
ванного символа только содержимое его первого кадра. Если все 

было сделано правильно, то вы должны были увидеть прыгающий 

мяч. Сравните с примером example3. Обратите внимание, что на 
Timeline задействован только один кадр, но в этом кадре распо-

ложен анимированный символ.  
 

Задание 6. Анимированная бабочка в про-

грамме растровой графике 
1. Создаем новый документ размером 500х500 цветовая 

модель RGB и прозрачный фон. 
2. Залейте его черным цветом при помощи инструмента 

"заливка". Создаем новый слой при помощи кнопки "создать но-

вый слой" внизу панели СЛОИ.  
3. Теперь создаем контур для бабочки - выбрав инстру-

мент "произвольная фигура" на панели инструментов и найдя там 
форму бабочки (если в программе отсутствует бабочка, исполь-

зуйте любой подходящий). Выберите для контура на панели задач 
инструмента режим "Контуры". Растяните фигуру бабочки на про-

зрачном слое.  

4. Выберите инструмент кисть, и задайте для нее сле-
дующие параметры(окно-кисти) - твердая кисть размером 9 пик-

селов с интервалом 175 процентов. Теперь ставим основным бе-
лый цвет.  
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5. На панели контуры (рядом с панелью слои) нажимаем 

кнопку "выполнить обводку контура кистью".  

 

  
Рис. 4.12. Выполнить обводку контура кистью 

 

6. Теперь добавим стиль "Crumble Metal" из панели 
СТИЛИ, если его нет, добавьте все стили из БИБЛИОТЕКИ 

СТИЛЕЙ. 

7. Создайте новый слой (при помощи кнопки "создать 
новый слой" внизу панели СЛОИ), между бабочкой и фоном и 

большой кистью поставите большую точку таким цветом какой 
вам больше нравиться. 

8. Создаем новый слой, называем его бабочка2. Перехо-

дим к панели КОНТУРЫ и нажимаем на кнопку "создать новый 
контур", называем КОНТУР1.  

 

 
Рис. 4.13. Контур 1 

9. Убедимся, что слой бабочка2 у нас активен. Теперь 

выбрав инструмент "произвольная фигура" на панели инструмен-
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тов и найдя там форму бабочки, растягиваем контур бабочки сде-

лав его меньше уже имеющейся у нас бабочки, при этом голова и 

тельце должны совпасть.  
 

 
Рис. 4.14. Добавление произвольной фигуры 

 

10. Переходим на панель КОНТУРЫ, делаем активным 
КОНТУР1. Выберите инструмент кисть, и задайте для нее следу-

ющие параметры - твердая кисть размером 9 пикселов с интерва-
лом 175 процентов. Теперь ставим основным белый цвет. На па-

нели контуры нажимаем кнопку "выполнить обводку контура ки-

стью". Добавим стиль "Crumble Metal" из панели СТИЛИ. 
11.  Создаем новый слой, называем его бабочка3. Пере-

ходим к панели КОНТУРЫ и нажимаем на кнопку "создать новый 
контур", называем КОНТУР2. 

12. Убедимся, что слой бабочка3 у нас активен. Теперь 

выбрав инструмент "произвольная фигура" на панели инструмен-
тов и найдя там форму бабочки, растягиваем контур бабочки сде-

лав его меньше чем КОНТУР1, но по прежнему так, чтобы голова 
и тельца бабочек совпали. 

13.  Переходим на панель КОНТУРЫ, делаем активным 
КОНТУР2. Выберите инструмент кисть, и задайте для нее следу-

ющие параметры - твердая кисть размером 9 пикселов с интерва-

лом 175 процентов. Теперь ставим основным белый цвет. На па-
нели контуры нажимаем кнопку "выполнить обводку контура ки-

стью". Добавим стиль "Crumble Metal" из панели СТИЛИ.  
14. Создаем новый слой, называем его бабочка4. Перехо-

дим к панели КОНТУРЫ и нажимаем на кнопку "создать новый 

контур", называем КОНТУР3. 
15. Убедимся, что слой бабочка4 у нас активен. Теперь 
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выбрав инструмент "произвольная фигура" на панели инструмен-

тов и найдя там форму бабочки, растягиваем контур бабочки сде-

лав его меньше чем КОНТУР2, но по прежнему так, чтобы голова 
и тельца бабочек совпали. 

16.  Переходим на панель КОНТУРЫ, делаем активным 
КОНТУР3. Выберите инструмент кисть, и задайте для нее следу-

ющие параметры - твердая кисть размером 9 пикселов с интерва-
лом 175 процентов. Теперь ставим основным белый цвет. На па-

нели контуры нажимаем кнопку "выполнить обводку контура ки-

стью". Добавим стиль "Crumble Metal" из панели СТИЛИ. 
17.  Откройте панель анимации (ОКНО-АНИМАЦИЯ), при 

помощи кнопки "Редактировать в ImageReady" (внизу панели ин-
струментов), если вы работаете в более ранней версии програм-

мы (или Window - Timeline (Окно - Шкала времени) и нажимаем на 

кнопку «Create Frame Animation» (Создать анимацию кадра). 
18.  Скопируйте первый кадр 5 раз (рис.4.15).  

 

 
Рис. 4.15. Анимированное 

 

19. вернемся к первому кадру анимации(кликнем по нему 
мышью), на панели Слои оставляем видимыми - фоновый слой, 

слойбабочка и слой с точкой (у остальных слоев отключаем види-

мость (значек ГЛАЗ), причем снижая прозрачность слоя с точкой 
до 30 процентов. 

20.  Во втором кадре оставляем видимыми фоновый слой, 
слой бабочка2 и слой с точкой, снижая прозрачность слоя с точ-

кой до 55 процентов. В третьем кадре оставляем видимыми фоно-

вый слой, слой бабочка3 и слой с точкой (меняя его прозрачность 
на 75 процентов). В четвертом кадре оставляем видимыми фоно-

вый слой, слой бабочка4 и слой с точкой (меняя его прозрачность 
на 100 процентов). В пятом кадре оставляем видимыми фоновый 

слой,слой бабочка3 и слой с точкой (меняя его прозрачность на 
75 процентов). В шестом кадре оставляем видимыми фоновый 

https://photoshoplessons.ru/perevod/window-timeline
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слой,слой бабочка2 и слой с точкой (меняя его прозрачность на 

55 процентов). 

21. Задайте время задержки каждого кадра 0,1 секунды.   
22. Нажмите кнопку PLAY посмотрите, что получилось.  

 
Задание 7. Создание кнопки 

1. Создайте новый фильм. Выберите команду 
Edit→Deselect All (Отменить выделение), чтобы гарантированно 

отменить все выделения на сцене.  

2. Выберите команду Insert→New Symbol….  
3. Преобразуйте кадры кнопки в ключевые кадры.  

4. В панели Properties введите имя нового символа кноп-
ки и выберите для него тип Button. Flash переключится в режим 

редактирования символа. 

Заголовок временной диаграммы изменяется и отражает 
четыре последовательных кадра, помеченные Up, Over, Down, 

Hit. Первый кадр является незаполненным ключевым кадром. 
5. Создайте изображение для различных состояний кнопки 

можно с помощью инструментов рисования или импортировав 
графические изображения или, использовав экземпляр другого 

символа. Можно использовать графический символ или символ 

фрагмента фильма в кнопке, но нельзя вкладывать одну кнопку в 
другую. Если хотите анимировать кнопку, используйте символ 

Movie Clip.  
6. Щелкните на втором кадре (рис. 4.16) и выберите ко-

манду Insert→Keyframe (Ключевой кадр). Flash вставляет клю-

чевой кадр, который дублирует содержание кадра. 
 

 
Рис. 4.16. Создание кнопки 
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7. Укажите изображение кнопки для состояния Over.  

8. Повторите шаги 5 и 6 для кадров Down и кадра Hit.  

Кадр Hit на сцене невидим, но именно он определяет об-
ласть кнопки, которая отзывается на щелчки указателя. Удосто-

верьтесь, что изображение для этого кадра занимает достаточно 
большую область и охватывает графические элементы кадров 

Down и Over, оно может быть даже больше, чем видимая кноп-
ка. Если кадр Hit не определен, то вместо него используется 

изображение кадра Up. 

Можно создать разнесенное чувствительное изображение, 
поместив кадр Hit в иное местоположение, чем другие кадры 

кнопки. 
Чтобы озвучить какое-то из состояний кнопки, выделите 

кадр этого состояния во временной диаграмме, выполните коман-

ду Modify→Frame чтобы открыть панель Frame (Кадр), и затем 
перейдите на вкладку Sound в этой панели. 

9. Выберите команду Edit→Edit Movie (Редактировать 
фильм). Перетащите символ кнопки из окна Library, чтобы со-

здать его экземпляр в фильме.  
 

Задание 8. Программа управления шаром 

1. Создайте символ (Name: shar, Behavior: Movie Clip). 
Для этого выбрать пункт меню  Insert→New Symbol. Нарисуйте 

анимируемый круг, с центром в точке (0; 0). После рисования 
выйти из символа (нажать на Scene 1 вверху над линейкой вре-

мени). 

2. Создайте символ (Name: Tr, Behavior: Button).  Для 
этого выберите пункт меню Insert→New Symbol. Нарисуйте 

треугольник с центром в точке (0; 0). После рисования выйдите 
из символа. 

3. Перенесите из библиотеки один символ shar и 4 симво-

ла Tr. Поверните 3 треугольника на 90, 180 и 270 градусов со-
ответственно. Разместите их как показано на рис. 4.17. 
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Рис. 4.17. Интерфейс программы управления объектом 
 

4. Дайте символу shar имя экземпляра shar1. Только 

Movie Clip может иметь имя экземпляра. По этому имени можно 
будет из программы обращаться к шару и менять его свойства 

(управлять им). 
 

Порядок выполнения работы 
1. Создайте символ (Name: shar, Behavior: Movie Clip). 

Для этого выбрать пункт меню  Insert→New Symbol. Нарисуйте 

анимируемый круг, с центром в точке (0; 0). После рисования 
выйти из символа (нажать на Scene 1 вверху над линейкой вре-

мени). 
2. Создайте символ (Name: Tr, Behavior: Button).  Для 

этого выберите пункт меню Insert→New Symbol. Нарисуйте 

треугольник с центром в точке (0; 0). После рисования выйдите 
из символа. 

3. Перенесите из библиотеки один символ shar и 4 симво-
ла Tr. Поверните 3 треугольника на 90, 180 и 270 градусов со-

ответственно. Разместите их как показано на рис. 3. 

4. Дайте символу shar имя экземпляра shar1. Только 
Movie Clip может иметь имя экземпляра. По этому имени можно 

будет из программы обращаться к шару и менять его свойства 
(управлять им). 

5. Выделите кнопку перемещения шара вверх и в панели 
Actions напишите программу, которая при событии щелчок 
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кнопкой мыши будет перемещать шар с именем shar1 на 10 пик-

селов вверх: 

 
on (release) { 

shar1._y = shar1._y-10; 

} 

 

6) Аналогично напишите скрипты для остальных трех кно-
пок. 

 
Задание 9. Самостоятельно придумайте и создайте 

анимационную сценку  

 
Контрольные вопросы  

 
1. Метода создания анимации. 

2. Виды автоматической анимации.  
3. Кадрированная анимация.  

4. Понятие ключевого кадра. 

5. Кадрирование движения. 
6. Кадрирование изменения размера и поворота. 

7. Назначение и порядок создания символа Button во Flash. 
8. Кадры во временной диаграмме символа Button и их назна-

чение. 

9. Как сделать кнопку интерактивной в фильме? 
10. Как настроить на выполнение конкретного действия экзем-

пляр кнопки? 
11. Анимация – составная часть мультимедиа. Классификация 

анимации. 
12. Виртуальная реальность. 

13. Цветовые модели: RGB. 

14. Цветовые модели: YUV. 
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ЛАБОРАТОРНАЯ РАБОТА № 5 СОЗДАНИЕ И РАБОТА СО 

ЗВУКОМ 

 
Цель работы формирование навыков использования компью-

терной техники и современных информационных технологий для 
решения практических задач; развитие умений и навыков рабо-

тать с мультимедиа приложениями для работы с музыкой и видео. 

 
Краткие теоретически сведения 

Работа со звуком на примере программы LMMS 
Виртуальная студия LMMS изначально разрабатывалась 

под Linux. Само название LMMS является аббревиатурой от Linux 

MultiMedia Studio. В настоящий момент эта программа доступна и 
для платформы Windows. LMMS во многом напоминает FL Studio 

(цифровая звуковая рабочая станция и секвенсер для написания 
музыки. Музыка создаётся путём записи и сведения аудио- или 

MIDI-материала), однако в отличие от именитого аналога являет-
ся бесплатной и распространяется по лицензии GPL. Данная ста-

тья ориентирована на пользователей FL Studio, которые желают 

перейти на свободное программное обеспечение. 
 

 
Упражнение 1. Запустить программу 
1. Программа LMMS (рис.5.1) 
 
 
 

Рис. 5.1. Окно 

LMMS 
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Рассмотрим её: 

 

Управление файлами 
Шесть кнопок в верхней строке имеют дело с открытием и 

сохранением файлов. 

Кнопка Создать новый проект создает новый проект. 

Кнопка « Создать новый проект из шаблона» позволит 
использовать сохраненные шаблоны для новых проектов. Нажав 

на значок, вы увидите список шаблонов, которые вы можете за-
грузить, это файлы mmpz, которые уже заполнены инструмента-

ми, барабанами и / или автоматизацией. Шаблоны могут сэконо-
мить вам много времени! Если вы, например, хотите удалить все 

четыре предварительно загруженные дорожки в новом проекте 

LMMS, вы можете сохранить пустой шаблон и открыть это вместо 
этого, каждый раз, когда вы хотите начать работу над новым про-

ектом. 

Кнопка « Открыть существующий проект» открывает су-

ществующий файл проекта из вашего рабочего каталога LMMS. 

Кнопка « Недавно открывшийся проект» перечисляет 

файлы, которые вы недавно сохранили в LMMS. Если вы открыли 
файл и не сохранили его из-за сбоя или других подобных обстоя-

тельств, файл не будет в списке. 

Кнопка Сохранить текущий проект сохраняет текущий 
проект. Если вы еще не сохранили проект, вам будет предложено 

указать имя и место для его сохранения. 

Кнопка « Экспорт текущего проекта» является ярлыком 
для экспорта текущего проекта в виде файла WAV или OGG. Это 

то же самое, что и в опции «Экспорт» меню «Файл». 
 

Управление окнами 
Семь кнопок во второй строке показывают или скрывают 

различные окна рабочей области. При щелчке действие зависит 

от текущего состояния этого окна. Если выбранное окно не нахо-
дится в передней части окна LMMS, оно выводится на передний 

план. Если он спереди, он закрыт. Если он закрыт, он открывается 
и выдвигается на передний план. Другими словами: это кнопки 

переключения для окон рабочей области. Содержимое окна не 

теряется при закрытии окна. Эти переключатели позволяют рабо-
тать в некотором рабочем пространстве с вкладками. Чтобы ис-

пользовать эту функцию, увеличьте все окна и используйте кноп-

https://lmms.io/documentation/File:Project_new.png
https://lmms.io/documentation/File:Project_new_from_template.png
https://lmms.io/documentation/File:Project_open.png
https://lmms.io/documentation/File:Project_open_recent.png
https://lmms.io/documentation/File:Project_save.png
https://lmms.io/documentation/File:Project_export.png
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ки-переключатели, чтобы вывести нужное окно вверх. 

Все графические интерфейсы имеют значок контекстного 

меню в верхнем левом углу окна. Щелкните значок или исполь-
зуйте правую кнопку мыши, чтобы открыть контекстное ме-

ню. Опция Stay On Top удерживает это окно поверх всех осталь-
ных окон. Это особенно полезно для FX-микшера, а также для не-

которых специальных трюков, которые он позволяет делать во 
время воспроизведения песни, например, в режиме реального 

времени . 

 
Кнопки Toggle: 

Переключатель Song-Editor отображает / скрыва-
ет редактор песен . 

В Удара + Bassline Editor кнопка показывает / скрыва-
ет Удар + Bassline Editor . 

В Piano Roll Editor Window кнопка показывает / скрыва-
ет редактор Piano Roll . Если вы нажмете кнопку переключения 

в пустом (новом) проекте, откроется пустое окно Piano-Roll, и по-
явится сообщение: «Пожалуйста, откройте шаблон, дважды 

щелкнув по нему!» Вы не можете редактировать это окно, потому 

что вы открыли окно редактора Piano-Roll, которое не связано с 
каким-либо треком! Вы должны закрыть это осиротевшее ок-

но. Тем не менее, окна Piano-roll, которые вы открываете, дважды 
щелкнув блок в редакторе песен (или сегмент в редакторе Beat + 

Baseline Editor), откроют окно редактора Piano-roll, связанное с 
дорожкой, в которую вы нажали, и 

вы теперь может редактировать свои заметки. 

Кнопка « Окно « Автоматизация » показывает / скрыва-
ет окно« Редактор автоматизации глобальной песни 

» . Автоматизация глобальных песен отличается от автоматиза-
ции треков. Вы получаете доступ к автоматизации глобальной 

песни, щелкнув правой кнопкой мыши элемент управления LMMS, 
а затем в контекстном меню выберите «Редактировать песню - 

глобальную автоматизацию». Затем это действие откроет окно 

«Редактор автоматизации», и вы можете создать автоматическую 
дорожку, специфичную для этого элемента управле-

ния. Предупреждение: нет визуальных «напоминаний» о том, что 
вы создали эту автоматизацию. Другими словами: если вы решите 

использовать «song-global-automation», вы должны обязательно 

отметить это в окне проектных заметок. Хорошая привычка - 
назвать дорожку автоматизации и разместить ее непосред-

https://lmms.io/documentation/File:Songeditor.png
https://lmms.io/documentation/File:Bb_track_btn.png
https://lmms.io/documentation/File:Piano.png
https://lmms.io/documentation/File:Automation.png
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ственно рядом с треком, который он контролирует. 

Переключатель FX-mixer показывает / скрывает FX-
микшер. 

Кнопка Project Notes показывает / скрывает окно Project 
Notes . Это заметки, напоминающие о чем-либо. Например: поче-

му вы делали так, как вы их делали, что вы собираетесь делать 

дальше. 

Переключатель- контроллер показывает / скрывает кон-

троллер-стойку; список контроллеров lfo и пиков в проекте. 
 

Управление темпом 

 Текущий темп показан цифрами. Это стандарт-
ный элемент управления, поэтому его можно изменить, перетас-

кивая его вверх и вниз, и его можно автоматизировать, удержи-

вая CTRL при перетаскивании на дорожку автоматизации. Если 
некоторое время темп, похоже, застрял, он может быть связан с 

глобальной автоматизацией. Щелкнув правой кнопкой мыши и 
выбрав «удалить песню-глобальную автоматизацию», проблема 

должна исправить. 

 
Таймер 

Таймер показывает время, которое 
потребуется, чтобы начать воспроизведение с начала песни до 

текущей позиции проигрывателя. Если вы нажмете на таймер, он 
может вместо этого показать, сколько полос, ударов и тиков про-

шло. Ticks подразделяет биты, в зависимости от выбранной вами 
подписи времени. Они также важны для автоматизации, потому 

что вы можете привязать кривую к тикам. В значении 4/4 по 
умолчанию, 32-й ноты длины, будут привязываться к 2. тиканию 

ритма. Свинг-ноты в перкуссии также привязаны к 2. тиканию, а 

не к удару. 
 

Контроль времени подписи 

 По умолчанию время подписи является 4/4. Вы мо-

жете изменить это, перетаскивая вверх или вниз и удерживая ле-

вую кнопку мыши. Сепаратор в рояле автоматически адаптирует-

https://lmms.io/documentation/File:Fx_mixer.png
https://lmms.io/documentation/File:Project_notes.png
https://lmms.io/documentation/File:Controller1.0.0.png
https://lmms.io/documentation/File:Tempo-bpm_1.0.0.PNG
https://lmms.io/documentation/File:Timer.png
https://lmms.io/documentation/File:Time-sig_1.0.0.PNG
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ся к выбранной сигнатуре времени. Так что же означает «подпись 

времени»? Значение по умолчанию 4/4 не отображает это хоро-

шо. Нам нужно взглянуть на другую сигнатуру времени, прежде 
чем мы сможем понять цифры. 3/4 также часто используется, и 

мы можем использовать это как пример. «4» в этой сигнатуре 
указывает, какая длина ноты имеет один бит. Таким образом, как 

в 4/4, так и в 3/4 подписи, один удар составляет 1/4 ноты! «3» 
обозначает количество ударов в одном баре. Так что в 4/4 мы 

имеем 4 удара в одном баре, но в 3/4 у нас всего 3 удара в одном 

баре. Вы можете читать гораздо больше о подписях времени и их 
важности в музыке здесь: http://www.musicarrangers.com/star-

theory/t19.htm Все, что сказал - Если ваш рейтинг выглядит 
странно странным, и вы не можете что-либо сделать, проверьте, 

случайно ли вы изменили подпись времени. 

Регуляторы громкости и высоты тона 
Справа от регулятора темпа расположены основные гром-

кости и настройки высоты тона. 

Регулятор Master Volume устанавливает мастер-
громкость для всей композиции. Почти всегда плохая идея изме-

нить это значение со 100% по умолчанию. 

Элемент управления Master Pitch устанавливает 

примечание «корень», на котором основывается каждая другая 

нота в песне. Поверните это, чтобы сделать пьесу на более низ-
ком уровне, и наоборот. Это может быть полезно, если вы запро-

граммировали воспроизведение песни в определенном ключе, и 

после проверки ее на оригинал вы обнаружите, что оригинал 
находится в другом ключе. Но будьте осторожны, потому что есть 

ловушка! Звуковые клипы могут быть испорчены, когда мастер-
шаг изменен, поэтому он не рекомендуется. 

 

Индикация использования волны и процессора 

Наконец, дисплей Wave / CPU отображает 
текущую форму сигнала, воспроизводимую во время воспроизве-

дения, и текущее использова- ние ЦП всех инструментов, эф-

https://lmms.io/documentation/File:Master_volume_1.0.0.PNG
https://lmms.io/documentation/File:Master_pitch_1.0.0.PNG
https://lmms.io/documentation/File:Wave_CPU_meter.PNG
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фектов и последовательности LMMS. Вы можете отключить или 

выключить волновой дисплей, щелкнув его, хотя это мало помо-

гает уменьшить использование ЦП, и это «окно» для главного вы-
вода. Вы увидите зеленые кривые, когда у вас нет обрез-

ки. Оранжевые кривые, когда обрезка – это risc, а красный гово-
рит вам, что вам нужно указать ситуацию отсечения в микшере. 

 
 

Плагины инструментов 

Когда вы нажимаете 
кнопку «Инструментальный 

плагин» , боковая па-
нель расширяется, чтобы 
отобразить доступные пла-

гины инструментов: 

 
Инструменты в LMMS 

1.0.0 
AudioFileProcessor - 

воспроизведение 
аудиофайлов. 

BitInvader - «простой 

и грязный» wavetable син-
тез. 

FreeBoy - эмулятор 
звукового чипа Nintendo 

Game Boy. 

Кикер- барабанный 
синтез. 

LB302 - монофониче-
ская реализация звука TB303. 

Mallets - синтезатор ударных инструментов 

Monstro - 3-осцилляторный синтезатор с синхронизацией 
импульсов и матрицей модуляции 

Nescaline - синтетическая эмуляция звукового чипа NES 
Opulenz - эмулятор FM-синтезатора Yamaha YM3812, также 

известный как OPL2 
Органический - синтетический синтезатор. 

PatMan - совместимый с GUS патч-инструмент. 

SF2 Player - официальный проигрыватель SoundFont2. 
SFXR - простой генератор звука 

https://lmms.io/documentation/File:Plugins.png
https://lmms.io/documentation/BitInvader
https://lmms.io/documentation/FreeBoy
https://lmms.io/documentation/Kicker
https://lmms.io/documentation/LB302
https://lmms.io/documentation/Mallets
https://lmms.io/documentation/Mallets
https://lmms.io/documentation/Monstro
https://lmms.io/documentation/Nescaline
https://lmms.io/documentation/Opulenz
https://lmms.io/documentation/Organic
https://lmms.io/documentation/PatMan
https://lmms.io/documentation/SF2_Player
https://lmms.io/documentation/SFXR
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SID - эмулятор звуковых чипов, используемых C64. 

TripleOscillator - «стандартный» модуль субтрактивного син-

теза. 
VeSTige - плагин VSTi-hosting. 

Vibed - модуль синтеза вибрационной струны. 
Вацин - 4-осцилляторный волновой синтезатор 

ZynAddSubFX - мощный гибридный синтезатор 

 

При наведении 
 

По умолчанию не выбран ни один плагин инструмента. При 

наведении курсора мыши на один, его окно будет расширяться 
, чтобы включать описание плагина: Вы можете перетащить ин-

струмент плагин либо в редакторе песни или Удар + Bassline 
Editor или дважды щелкните инструмент плагин этикетки , чтобы 

добавить его прямо к редактору Beat + Bassline. 

Навигация раздела 
Во всех разделах, кроме раздела «Плагины инструментов», 

список, который вы получаете, подобен дереву каталогов. Папки 
отмечены значком папки. Если вы нажмете флажок слева от 

значка папки, откроется папка и отобразится ее содержимое с 
отступом справа от имени 

папки. Чтобы закрыть его, 

снова нажмите на флажок. 
 

Эти папки такие же, как 
на вашем компьютере, что 

позволяет вам удобно откры-

вать звуки и пресеты на ва-

https://lmms.io/documentation/SID
https://lmms.io/documentation/TripleOscillator
https://lmms.io/documentation/VeSTige
https://lmms.io/documentation/Vibed
https://lmms.io/documentation/Watsyn
https://lmms.io/documentation/ZynAddSubFX
https://lmms.io/documentation/File:Sidebar1.0.0_instrumentplugin_info.png
https://lmms.io/documentation/Song_Editor
https://lmms.io/documentation/Beat_Bassline_Editor
https://lmms.io/documentation/Beat_Bassline_Editor
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шем жестком диске из LMMS. 

Открытые папки можно искать в интеллектуальном поиске, 

поэтому вы можете найти элемент с маркером поис-
ка. Используйте небольшое поле ввода внизу.  

Просто введите несколько символов из имени файла элемента, а 
интеллектуальный поиск в LMMS будет фильтровать имена в те-

кущей открытой папке.  
Смарт-поиск не ищет подпапки! 

Справа от поля ввода находится кнопка «Обновить». Если 

вы не можете найти вновь созданный файл, нажмите кнопку «Об-
новить»: все папки будут обновлены, и дерево рухнет (это также 

простой способ закрыть все открытые папки). 
Давайте поближе рассмотрим вкладки. 
 

Мои проекты 

 
Второй вариант на боко-

вой панели; ярлык к папке-

браузеру проекта. В зависимо-
сти от ваших созданных пользо-

вателем подпапок будет созда-
но дерево-браузер. Дважды 

щелкните имя проекта, который 

хотите загру-
зить. Дождитесь полной загрузк

и проекта , прежде чем исполь-
зовать другие функции в LMMS! 

Следующие 2 вкладки на 
боковой панели содержат ваши 

инструменты. Это образцы и 

инструменты. Оба имеют по-
добное поведение. 

 
Образцы 

Образцы или MySamples 

по имени вкладки дают вам лег-
кий доступ к коллекции образ-

цов LMMS. Образцы могут быть 
звуковыми файлами WAV, OGG 

и flac. У вас есть интеллекту-
альный поиск и вы можете об-

новить дисплей. Чтобы про-

смотреть образец, щелкните левой кнопкой мыши и удерживай-
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те его имя. Перетащите образец в редактор Song или Beat + 

Bassline-Editor, чтобы добавить его в качестве нового трека. Когда 

вы перетаскиваете образец в любой редактор, новый трек будет 
добавлен в нижней части списка дорожек. Вы можете перетащить 

точки захвата в левый конец дорожки, чтобы переместить дорож-
ку туда, где вы хотите, в списке дорожек. Дважды щелкните об-

разец, чтобы добавить его в Beat + Bassline-Editor в качестве но-
вого трека. Символ курсора мыши отобразит знак отклонения при 

перетаскивании, если образец не может быть сброшен в это окно. 

Пресеты 
 

Предустановки или MyPresets 
в качестве вкладки названы, дает 

вам легкий доступ к коллекции 

предопределенных инструмен-
тов. Предустановки - это плагины с 

предустановленными настройками и 
настроенными элементами управле-

ния. У вас есть поле поиска внизу, и 
вы можете обновить дисплей, нажав 

кнопку обновле-

ния. Предупреждение : вы должны 
сделать привычкой сохранять свой 

проект перед тем, как предвари-
тельно просмотреть пресет (т.е. Перед тем, как левый клик и 

удерживать предустановку), потому что иногда предварительный 

просмотр может привести к сбою LMMS. Еще одна вещь, которую 
вы должны помнить, - никогда не просматривать предваритель-

ный набор VeSTige! Команда VST не создается командой LMMS, и 
они не могут обрабатываться, как могут наши собственные ин-

струменты. Повторяю: никогда не просматривайте VST! 

Перетащите предустановку в редактор Song или Beat + 
Bassline-Editor, чтобы добавить его в качестве нового трека. Если 

вы перетащите предустановку в (т.е. поверх нее) существующий 
пресет в любом из редакторов, 

он заменит предыдущий пре-
сет. В противном случае при пе-

ретаскивании предустановки в 

любой редактор новый трек бу-
дет добавлен в нижней части 

списка дорожек. Вы можете пе-
ретащить точки захвата в левый 
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конец дорожки, чтобы переместить дорожку туда, где вы хотите, 

в списке дорожек. Дважды щелкните пресет, чтобы добавить его 

в Beat + Bassline-Editor в качестве нового трека. Символ указателя 
мыши покажет нулевой знак при перетаскивании, если пресет не 

может быть сброшен в это окно. Вы также можете щелкнуть пра-
вой кнопкой мыши любой пресет и использовать контекстное ме-

ню, чтобы добавить его в редакцию. Этот способ добавления пре-
сетов дает вам очень хороший контроль, и вы всегда должны ис-

пользовать этот метод, когда работаете с VST. 

 
Мой дом 

 
5-я вкладка на боковой панели My Home - это ярлык для 

конкретной папки в вашей системе. В системах Windows это соот-

ветствует папке% HOMEPATH% (то есть текущего профиля поль-
зователя), содержащей такие папки, как Desktop, Favorites, 

MyDocuments и т. Д. 
 

 
Мой компьютер 

Последняя вкладка на 

боковой панели является 
ярлыком для корня дерева 

папок вашего компьюте-
ра. Вы можете просматри-

вать дерево и даже исполь-

зовать токен-поиск. Очень 
удобно для общих целей. 

 
 

 

 
Редактор песни отображает структуру песни. 
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В левой части окна отображаются дорожки инструмента и 
бит / бас-линии. 

В правой части окна отображается фактическое содержи-
мое - блокнот или сегменты каждого трека на каждой панели в 

проекте. 
 

Работа с сегментами 

Анатомия трека: 
Каждый трек имеет контент в ви-

де сегментов или элементов , часто вы будете слышать других 
пользователей, использующих термин «блоки».  

 Для инструментальных треков дисплей представляет 
собой миниатюрный рояль для фортепиано.  

Двойной щелчок на нем откроет окно редактора пианино-

роллеров, в котором вы можете добавлять, удалять или изменять 
отдельные заметки. 

 Для пробных треков дисплей представляет со-
бой миниатюрный сигнал образца.  

Двойной щелчок по нему откроет диалог File-Open, в котором вы 
можете выбрать новый образец для этого элемента.  

LMMS не может редактировать записанные звуки, и звук 

LMMS не звучит! 

 Для Beat / Bassline Tracks дисплей представляет 
собой просто цветной блок / сегмент, показывающий, что бит / 

басовая линия активна.  

Двойной щелчок по нему откроет окно редактора Beat + 

https://lmms.io/documentation/File:Song_Editor_default1.0.0.png
https://lmms.io/documentation/File:Instrument_pattern_Song_Editor1.0.0.png
https://lmms.io/documentation/Piano_Roll_Editor
https://lmms.io/documentation/Piano_Roll_Editor
https://lmms.io/documentation/File:Sample_track_pattern1.0.0.png
https://lmms.io/documentation/File:BeatBassline_pattern1.0.0.png
https://lmms.io/documentation/Beat_Bassline_Editor
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Bassline Editor, в котором вы можете добавлять, удалять или из-

менять отдельные заметки в такте. 

Чтобы создать новые сегменты , щелкните левой кнопкой 
мыши в области действия трека в панели, где вы хотите, чтобы 

сегмент начинался. Для инструментальных и выборочных доро-
жек это создает пустую область, где вы можете поместить замет-

ки или образцы. Для дорожек бит / бас-линии это создает 1 (или 
более) бары, заполненные этой конкретной Beat + Bassline, как 

сконфигурировано. 

Чтобы переместить сегмент , перетащите его, щелкнув и 
удерживая сегмент. По мере того как он перетаскивается, сегмент 

будет привязываться к началу любой полосы, но вы можете сво-
бодно перетаскивать (с 1/64-м разрешением), удерживая клавишу 

Ctrl после начала перетаскивания (Ctrl + перетащить, прежде чем 

вы начнете перетаскивать инициирует «копию» " процедура). 
Чтобы скопировать сегмент , удерживайте клавишу 

Ctrl до начала перетаскивания, а затем перетащите копию в новое 
место. Вы также можете щелкнуть правой кнопкой мыши по сег-

менту, выбрать копию , щелкнуть левой кнопкой мыши, чтобы 
создать пустой сегмент, в котором вы хотите, чтобы копия про-

шла, щелкните правой кнопкой мыши и выберите вставить . Вы не 

можете копировать сегменты одного типа дорожки на дорожки 
другого типа. Чтобы снова скопировать, клавиша управления 

должна быть отпущена и повторно нажата до следующей опера-
ции перетаскивания. 

Чтобы удалить сегмент , щелкните его с помощью средней 

кнопки мыши или щелкните его правой кнопкой мыши и выберите 
« Удалить» . Двойной щелчок по блоку открывает редактор фор-

тепиано или Beat & bass, поэтому вы можете редактировать со-
держимое сегментов . 

Панель инструментов редактора песен 

  
В окне редактора песен есть панель инструментов, которая поз-

воляет вам управлять воспроизведением песни, добавлять новые 
треки, выбирать инструменты редактирования, настраивать спо-

соб воспроизведения и управлять общим видом песни.  

Давайте рассмотрим все инструменты. 
Инструменты редактирования 

Инструмент режима рисования 
Несмотря на различный контент, способы работы с сегмен-

https://lmms.io/documentation/Beat_Bassline_Editor
https://lmms.io/documentation/File:Song_Editor_toolbar1.0.0.png
https://lmms.io/documentation/File:Song_Editor_toolbar1.0.0.png


 

Управление цифровых образовательных технологий 

Мультимедиа технологии 

 

 99 

тами в основном схожи.  

 Большая часть работы в Song-Editor выполняется с помо-
щью инструмента « Режим рисования» . 

щелкните левой кнопкой мыши на пустой панели, чтобы 

добавить сегмент 
щелкнуть по блоку, чтобы удалить его 

Ctrl + средний щелчок - это переключатель mute / unmute 
для этого блока 

щелкните правой кнопкой мыши по сегменту, чтобы полу-
чить контекстное меню 

левое перетаскивание по сегменту, чтобы переместить его 

(блок будет привязываться к границам границ) 
Ctrl после того, как левое перетаскивание начинается на 

сегменте, чтобы свободно перемещать его (не будет привязы-
ваться к границам) 

Ctrl, перед тем, как левое перетаскивание начинается с сег-

мента, чтобы скопировать его 
Когда вы наводите указатель мыши на правый конец сег-

мента, курсор мыши становится двунаправленной стрелкой, по-
этому вы можете перетащить конец сегмента, чтобы он растянул-

ся на большее или меньшее количество баров - это не работает 
для дорожек инструмента! 

left-drag = расширение сегмента / ретракция для привязки 

границ 
Ctrl + left-drag = расширение / отрыв сегмента свободным 

(не привязывается к границам границ) 
 

Инструмент режима редактирования 

 Инструмент « Редактировать режим» , также известный 
как инструмент выбора, позволяет перетаскивать прямоугольное 

поле выбора, которое выбирает несколько сегментов. Затем вы 
можете обрабатывать выделение в виде группы.  

Выбранные сегменты меняют свой цвет, чтобы отличать их от не 
выбранных 

Ctrl + левый клик по любому сегменту, который вы хотите 

удалить из группы выбора 
перетащите горизонтально на любой выбранный сегмент, 

чтобы переместить группу выбора: 
left-drag = движение, где сегменты привязаны к границам 

границ 
Alt + left-drag = свободное перемещение (сегменты не при-

https://lmms.io/documentation/File:Edit_draw1.0.0.png
https://lmms.io/documentation/File:Edit_select.png
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вязываются к границам) 

Нажмите на любую пустую панель, чтобы удалить выделе-

ние из выбранных сегментов. 
Отмеченные блоки можно не только перемещать, но и ко-

пировать (ctrl + c) и вставлять (ctrl + v) в позицию игрового стола 
в любом месте вашего проекта.  

Вы также можете удалить (DEL) отмеченные блоки.  
Рекомендуется использовать настройки увеличения, чтобы 

найти увеличение, которое дает вам наилучший вид вашего про-

екта. Начиная с 1.2, LMMS имеет увеличение на 12,5%, что поз-
воляет увидеть 350 баров вашего проекта! 

Изменение структуры проекта 
Иногда нужно удалить весь сегмент проекта, или вам нужно 

место для вставки новых блоков. Здесь вы используете INSERT и 

DELETE  
Fist, чтобы переместить головку в положение, в котором вы хоти-

те изменить.  
Развертывание проекта  

Shift + Insert-key вставляет новую пустую строку справа от теку-
щей позиции проигрывателя на все дорожки.  

В результате вы по существу подталкиваете все вверх и, 

следовательно, получаете более длинный проект!  
Конденсация проекта  

Shift + Delete-клавиша перемещает все одну полосу слева 
от текущей позиции проигрывателя.  

Вы по существу вытаскиваете все вниз и, следовательно, получа-

ете в результате более короткий проект! 
Оба метода являются мощными инструментами для внесе-

ния больших изменений в ваш проект. 
 

Навигационный 

Полосы прокрутки в правой и нижней части окна позволяют 
перемещать просмотр редакторов, но вы также можете прокручи-

вать колесиком мыши!  
Используйте Shift + колесико мыши для прокрутки по горизонта-

ли.  
Используйте Ctrl + колесико мыши для прокрутки по вертикали. 

Элементы управления воспроизведением 

Play кнопка начинает воспроизведение в текущей пози-
ции Playhead. Клавиатура имеет аналогичную функциональность, 

в зависимости от настро-
ек режимавоспроизведения кнопки « Возврат» . (Смотри ниже). 

https://lmms.io/documentation/File:Play.png
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 Во время воспроизведения значок кнопки « Пау-

за» представляет значок кнопки «Воспроизведение». Он приоста-
навливает воспроизведение и оставляет точку воспроизведения в 

текущей позиции. 

 Кнопка Stop (или пробел клавиатуры) останавливает 
воспроизведение (или приостановленное воспроизведение) и 

возвращает точку воспроизведения в положение, определенное 
кнопкой возврата (см. Ниже).  

 
Кнопка режима возврата - это 3-позиционный переключа-

тель, который управляет перемещением точки воспроизведения 
при остановке воспроизведения с помощью кнопки 

«Стоп». Существует 3 режима: 

 Возврат в нуль (по умолчанию): playhead возвращается 
к началу песни (bar # 1). 

 В начало  : головка воспроизведения возвращается в 
положение начала воспроизведения. 

Продолжить  : точка воспроизведения остается там, где 
она была остановлена (т.е. она не перемещается). 

 
Между кнопкой « Воспроизведение» и кнопкой « Стоп» есть две 

другие кнопки: 

 «Запись образцов из аудиоустройства» 

 «Запись образцов с аудиоустройства во время воспро-
изведения песни или дорожки BB» 

Они выделены серым цветом и еще не имеют функциональ-
ности.  

Автоматическая прокрутка кнопка по умолчанию. Во 
время воспроизведения представление в окне «Редактор песни» 

автоматически прокручивается по горизонтали, чтобы отобразить 

текущую позицию воспроизведения. Когда игровая головка пере-
мещается за правый край окна, окно будет прокручиваться гори-

зонтально, так что точка воспроизведения продолжается на ле-
вом краю. В настройках исполнения опция «плавная прокрутка» 

может быть включена. При выключенном автопрокрутке головка 
воспроизведения может исчезнуть во время воспроизведения. 

 

 По умолчанию кнопка Loop-points выключена. При включении 
значки петлевой точки стано- вятся активными (ярко-

https://lmms.io/documentation/File:Pause.png
https://lmms.io/documentation/File:Stop.png
https://lmms.io/documentation/File:Back_to_zero.png
https://lmms.io/documentation/File:Back_to_start.png
https://lmms.io/documentation/File:Keep_stop_position.png
https://lmms.io/documentation/File:Record.png
https://lmms.io/documentation/File:Record_accompany.png
https://lmms.io/documentation/File:Autoscroll_on.png
https://lmms.io/documentation/File:Loop_points_on.png


 

Управление цифровых образовательных технологий 

Мультимедиа технологии 

 

 102 

зелеными) на временной шкале. Вы можете перетаскивать точки 

цикла по временной шкале следующим образом: 

конечная точка цикла (определенная как точка цикла спра-
ва): правая кнопка мыши + перетаскивание 

start loop point (определяется как точка цикла слева): Shift 
+ правая кнопка мыши ИЛИ Средняя кнопка мыши + перетаски-

вание 
По умолчанию точки петли являются «магнитными», что 

означает, что при их перетаскивании они привязаны к ближайшей 

границе бара; однако вы можете удерживать клавишу Ctrl при 
перетаскивании, чтобы расположить их с большей точностью. Во 

время воспроизведения Song-Editor игровая точка будет непре-
рывно вращаться между точками старта и конца. Это полезно для 

тестирования определенного раздела вашей пьесы, но оно суще-

ствует только в режиме воспроизведения. Это не способ повто-
рить раздел определенное количество раз в вашей композиции - 

вам придется использовать для этого копию / вставку. 
Добавление треков 

Нет кнопки для добавления новой дорожки инструмента. Вы 
добавляете новую дорожку инструмента, перетаскивая желаемый 

плагин или предустановку из боковой панели в пустую область в 

редакторе песен. Затем нажмите на название дорожки инстру-
мента, чтобы показать / скрыть окно редактора инструментовдля 

этого плагина . В этом окне вы можете вносить изменения в звук 
инструмента. 

 Чтобы добавить новую дорожку Beat / Bassline, нажмите 
кнопку Add beat / bassline . Щелкните правой кнопкой мыши имя 

дорожки / бас-линии, чтобы переименовать его в нечто более 

значимое. 

 Чтобы добавить новый образец трека, нажмите кнопку 

« Добавить образец-трек» . 
 

Управление увеличением 

 Это управление масштабированием . Вы 

можете увеличивать масштаб, чтобы отображать меньше баров 
или уменьшать масштаб, чтобы отображать больше баров в 

окне. Существует несколько способов увеличения: 
наведите указатель мыши на номер увеличения и поверни-

те колесо прокрутки мыши вверх / вниз, чтобы увеличить / 
уменьшить 

https://lmms.io/documentation/Side_Bar
https://lmms.io/documentation/Instrument_Editor
https://lmms.io/documentation/Plugins
https://lmms.io/documentation/File:Add_bb_track.png
https://lmms.io/documentation/File:Add_sample_track.png
https://lmms.io/documentation/File:Zoomsection1.0.0.png
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наведите указатель мыши в другое место в окне редактора 

песен и Ctrl + mouse-scroll-wheel вверх / вниз, чтобы увеличить / 

уменьшить 
щелкните левой кнопкой мыши по значку Zoom для увели-

чения на 1 уровень; щелкните правой кнопкой мыши по номеру 
Zoom, чтобы уменьшить масштаб на 1 уровень 

используйте стрелку вниз Zoom и выберите уровень мас-
штабирования 

Изменение высоты дорожки : в любом месте трека исполь-

зуйте Shift + drag, чтобы изменить высоту дорожки. Вы можете 
сделать его выше, чем высота по умолчанию, а не короче. 

Панель настроек трека 

 Левая 

сторона дорожки, панель настроек трека, содержит кнопки и эле-
менты управления, которые позволяют работать с дорожкой в 

целом. 

 Заштрихованная область в левом конце дорожки - ручка 

Grip . В режиме рисования используйте его, чтобы перетащить 
дорожку вверх или вниз в порядке укладки треков. Трек-ордер не 

влияет на создаваемые звуки, он просто помогает вам организо-
вывать все. Ctrl + перетаскивание рукоятки захвата делает клон 

трека, который можно разместить либо в нижней части списка 
дорожек, и в редакторе Beat & Bass, либо даже в другом открытом 

проекте, если у вас достаточно ОЗУ для двух экземпляров LMMS.  

Вы используете значительно меньше оперативной памяти, если 
только копируете-перетаскиваете и не играете ни в один из про-

ектов! 
 

Трек Инструменты значок имеет всплывающую подсказку 
, которая говорит «Действия по этому пути». Нажмите на нее, 

чтобы увидеть меню с опциями: 

Клонировать этот трек делает точную копию трека 
(настройки инструмента и сегменты) и вставляет его в конец 

списка дорожек. 
Удалить эту дорожку удаляет дорожку 

MIDI . Опция для инструментов для подключения MIDI-

устройства. 

 Переключатель Mute / unmute выглядит как зеленый 
светодиод, который вы включаете и выключаете, нажимая на не-

https://lmms.io/documentation/File:Song_editor_automation_track1.0.0.png
https://lmms.io/documentation/File:Track_op_grip.png
https://lmms.io/documentation/File:Trackop.png
https://lmms.io/documentation/File:Mute_unmute_solo1.0.0.png
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го. Используйте его, чтобы временно отключить звуки с этой до-

рожки. Например, вы можете услышать дорожку сопутствующего 

инструмента без прослушивания ведущего инструмен-
та. Поскольку все регуляторы, светодиоды и фейдеры в LMMS мо-

гут быть автоматизированы . Переключатель Solo / unsoloэто вто-
рой свет, один справа. Это красный светодиод, который вы вклю-

чаете и выключаете, нажимая на него. Используйте его, чтобы 
временно отключить все остальные треки, кроме этой дорожки, 

или добавить некоторые другие треки к воспроизведению, просто 

отключив любую дорожку по своему выбору. Таким образом, вы 
можете иметь один соло-трек плюс любое количество выбранных 

треков, играющих вместе в одиночку. Если вы хотите снова акти-
вировать все дорожки, вы просто не соло соло-трек. Это снова 

отключит все дорожки в редакторе песен. 

 
В остальной части панели настроек трека отображает-

ся информация источника звука . Это немного различается между 
дорожками инструмента, образцовыми дорожками и дорожками 

бит / бас-линии. 

  

Следы инструмента : 
громкость и управление панорамированием 

( автоматическое ), 
кнопка, которая отображает имя предустановки инструмен-

та: 

щелчок левой кнопкой мыши открывает редактор инстру-
ментов 

щелкните правой кнопкой мыши, откроется диалоговое ок-
но, чтобы переименовать дорожку 

 

Свет активности представляет собой прямоугольный индикатор 
, расположенный далеко прямо в приборных треках, который за-

горается , когда прибор воспроизводит ноту. Вы можете щелкнуть 
по нему, чтобы просмотреть звук инструмента. 

  
Образцы треков : 

регулятор громкости ( автоматически ) 
кнопка, отображающая название дорожки: 

левой кнопкой мыши открывается редактор эффектов, где 
вы можете выбрать эффекты для добавления 

https://lmms.io/documentation/Working_with_Automation
https://lmms.io/documentation/File:Song_editor_instrument_track1.0.0.png
https://lmms.io/documentation/Working_with_Automation
https://lmms.io/documentation/0.4:Instrument_Editor
https://lmms.io/documentation/0.4:Instrument_Editor
https://lmms.io/documentation/File:Song_editor_sample_track1.0.0.png
https://lmms.io/documentation/Working_with_Automation
https://lmms.io/documentation/LADSPA
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щелкните правой кнопкой мыши, чтобы открыть диалог, 

чтобы переименовать дорожку 

 

  
Треки Beat / Bassline имеют: 

кнопка, отображающая название дорожки: 
щелчок левой кнопкой мыши открывает редактор Beat + 

Bassline Editor , если он еще не открыт 
щелкните правой кнопкой мыши, чтобы открыть диалог, 

чтобы переименовать дорожку 

Контекстное меню треков 
Контекстное меню трека появляется, когда вы щелкаете 

правой кнопкой по сегменту в треке. Доступные варианты варьи-
руются в зависимости от типа дорожки следующим образом: 

Контекстное меню треков 

Открыть в фортепья-
но-рулоне открывает шаб-

лон с щелчком мыши 
в редакторе фортепианного 

ролика . 
Удалить удаляет сег-

мент с щелчком. 

Cut удаляет сегмент с 
щелчком и помещает его в 

буфер обмена. 
Копия делает копию 

щелкнутого сегмента и по-

мещает его в буфер обме-
на. 

Паста вставляет со-
держимое буфера обмена в 

этот сегмент, перезаписы-

вая его предыдущее содержимое. Название сегмента копируется 
и вставляется с содержимым сегмента, что помогает вам увидеть 

исходный источник этого сегмента (см. Ниже «Изменить имя»). 
Mute / Unmute позволяет отключить звук нажатого сегмен-

та. Это не влияет на объем остальных сегментов дорожки. 
Очистка всех заметок позволяет удалить содержимое сег-

мента с щелчком, не удаляя сам сегмент. 

Имя сбрасывает имя сегмента для имени дорожки, а имя 
снова скрывается. 

https://lmms.io/documentation/File:Song_editor_beatbassline1.0.0.png
https://lmms.io/documentation/Beat_Bassline_Editor
https://lmms.io/documentation/Beat_Bassline_Editor
https://lmms.io/documentation/Piano_Roll_Editor
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Имя изменения позволяет вам изменить название сегмен-

та. Сегменты в дорожке могут иметь свои собственные имена, и 

по умолчанию название сегмента совпадает с именем дорожки. 
Добавить шаги и шаги удаления позволяют добавлять или 

удалять количество шагов в панели. Это тот же вариант, что и 
в редакторе Beat + Bassline . 

 
Контекстное меню проб-

ной дорожки 

Действия каждой опции 
по существу те же, что и для 

дорожки инструмента вы-
ше. Функция записи еще не 

функционирует. 

 
 

 
 

Контекстное меню трека Beat / Bassline Track 
 

Действия каждой 

опции по существу те же, 
что и для дорожки ин-

струмента вы-
ше. Единственное допол-

нение: 

Изменение цве-
та позволяет изменить 

цвет сегментов на дорож-
ке BB. Это поможет вам 

отличить функцию или 

содержание дорожек от их 
цвета и поможет вам 

быстро узнать, с какой 
бас-линией вы работаете в сложных секциях ритма. Вы можете 

использовать инструмент Edit Mode Tool aka Selection Tool, чтобы 
выбрать группу сегментов Beat + Bassline и сразу же покрасить 

их. 

 
Повторное использование и копирование дорожек 

Иногда вы можете использовать заметки, которые у вас 
есть в другом проекте. Вы не можете использовать заметки в дру-

https://lmms.io/documentation/Beat_Bassline_Editor
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гих проектах, как ссылку , но! Вы можетекопировать эти заметки 

из одного проекта в другой! Допустим, у нас хороший арпеджио, 

и нам нравится использовать его с небольшими изменениями в 
новом проекте.  

Метод 1  
Если у вас есть достойное оборудование, с «лотами» (2+ 

гб), вы можете одновременно работать с двумя 
LMMS одновременно . Наведите указатель на дорожку с суще-

ствующим арпеджио. На трек-кнопке у нас есть бордюрный брус, 

самый левый на этой картин-

ке:  
Удерживать Ctrl 

точка на благородном баре 

нажмите и перетащите всю трек-кнопку из проекта «донор» 
в редактор песен получающих проектов. 

Теперь вы скопировали все заметки и пресет в новый про-
ект! - В нашем случае у нас были бы «оба» арпеджио-ноты, и 

«все арпеджио-настройки в пресете, скопированные в новый про-

ект. Если вы создаете проект под названием «.my-aprs.mmp» и 
строите все арпы, вы можете подумать, тогда вы можете исполь-

зовать этот проект в качестве шаблона для любого проекта, 
и таким образом у вас есть арпеджио-библиотека. 

Метод 2  
Это совсем не так сильно, но может быть использовано кем 

угодно, несмотря на низкое значение hw. 

Откройте образец рояля в проекте 1 
отметить все (Ctrl + a) 

Скопировать все (Ctrl + c) 
Создать новый проект или открыть существующий проект 

Откройте пианино в этом проекте 

вставьте заметки из первого проекта (Ctrl + v) 
Как вы можете видеть, у нас только один экземпляр 

LMMS открыт, и это очень удобный способ копирования между 
программами, но мы получили только заметки из одного блокно-

та с помощью этого простого метода. 
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Задание 1. Ваша Первая Мелодия 

Изучим работу программы и самостоятельно создадим му-

зыку. 
 

Контрольные вопросы  

 

1. Понятие мультимедиа. Виды мультимедийных устройств.  
2. Понятие мультимедийных программ. Виды мультимедий-

ных программ.  
3. Возможности программы создания музыки.  

4. Технология создания музыки.  

5. Назначение Шкалы времени.  
6. Назначение Шкалы раскадровки.  

7. Дорожки, входящие в состав Шкалы времени.  
8. Способы сохранения.  

9. Цифровое аудио – составная часть мультимедиа. 
10. Принципы оцифровки аналогового звука. 

11. MIDI-аудио – составная часть мультимедиа. 

12. Форматы звуковых файлов. 
13. Устройство и функционирование звуковых карт. 
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ЛАБОРАТОРНАЯ РАБОТА № 6 СОЗДАНИЕ И РАБОТА С 

ВИДЕО 

Цель работы формирование навыков использования компью-
терной техники и современных информационных технологий для 

решения практических задач; развитие умений и навыков рабо-
тать с мультимедиа приложениями для работы с музыкой и видео. 

 

Краткие теоретически сведения 
Работа с видео на примере программы Wondershare 

Filmora 
Программа Filmora имеет набор функций, которые помогут 

создать полноценный фильм. В ней присутствуют разнообразные 

фильтры и есть возможность работы с видео- и аудиодорожками. 
Доступна для скачивания бесплатная и платная версии. Главное 

преимущество – меню на русском языке. 
В целом программа похожа на Video Editor. Рабочее окно 

утилиты разделено на три части: снизу отображаются аудио- и 
видеодорожки, слева вверху – набор функций, которые применя-

ются при редактировании файла, справа вверху – область пред-

варительного просмотра. 
 

Упражнение 1. Запустить программу 
1. Программа Wondershare Video Editor (рис.6.1) 

2.  

 
Рис. 6.1. Окно Wondershare Video Editor 

 

Рассмотрим её: 
 

Выбор режима редактирования видео 
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Wondershare Video Editor имеет два различных режима ре-

дактирования видео. После запуска Video Editor выберите либо 

Easy Mode (Простой режим) для редактирования с использовани-
ем интеллектуальных тем заставок Video Editor, либо Full Feature 

Mode (Полнофункциональный режим) с полностью настраивае-
мыми пользователем функциями редактирования. Убедитесь, что 

при запуске проекта вы выбрали правильную пропорцию для 
отображения своего видео (4:3 или 16:9). 

Мастер Easy Wizard Mode 

После того как вы решили запустить свой видеопроект в 
простом режиме (Easy Mode): 

 

 
Рис. 6.2. Окно Wondershare Video Editor 

 

1. В панели "Add Media File" ("Добавить медиафайл") мож-

но нажать "Import" ("Импорт"), чтобы загрузить все видео и изоб-
ражения, которые вы хотите включить в ваш проект. Можно пе-

ретаскивать объекты, чтобы расположить их в порядке обработ-
ки. Щёлкните объект правой кнопкой мыши, чтобы выбрать оп-

цию повернуть изображение. Когда будете готовы к следующему 
шагу, нажмите "Next" ("Дальше"). 

2. Выберите шаблон, который больше всего соответствует 

вашему видеосюжету или загрузите новые с интернет-ресурса. 
После выбора тема для вашего видео нажмите кнопку "Next" 

("Далее"), чтобы перейти к следующему шагу. 
3. Далее есть возможность выбрать фоновую музыку. Её 

можно выбрать из представленного списка или загрузить из соб-
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ственных музыкальных файлов. Когда будете готовы к следующе-

му шагу, нажмите "Next" ("Дальше"). 

4. В меню "Preview" можно настроить вступительный и за-
ключительный текст вашего видеосюжета. Нажмите кнопку "Play" 

для предварительного просмотра своего видео. Если вы хотите 
ещё что-то изменить, нажмите кнопку "Previous"("Предыдущий") в 

нижней части, чтобы вернуться к предыдущим шагам для внесе-
ния новых корректив. 

 

 
Рис. 6.3. Окно Wondershare Video Editor 

 

5. Если вы удовлетворены предварительным просмотром 
видео, нажмите "Next", чтобы сохранить проект. "Export Directly" 

дает возможность либо сохранить свой сюжет в каком-либо ви-

део-формате. 
 

Мастер Full Wizard Mode 
После того как вы решили запустить свой видеопроект в 

полнофункциональном режиме (Full Feature Mode): 
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Рис. 6.4. Окно Wondershare Video Editor 

 
Импортируйте и добавляйте медиафайлы 

Нажмите кнопку Import, чтобы выбрать на компьютере 

видео, аудио и фото, или нажмите Record. Можно также перетас-
кивать файлы в свой альбом пакетно. 

Для редактирования медиафайлов или создания нового 
видео, перетаскивайте медиафайлы из альбома на шкалу в ниж-

ней части.  
Редактируйте видео, фото и аудио 

На временной шкале можно вырезать, копировать, встав-

лять и удалять любые клипы в любое время, а также отменять 
действия нажатием Undo (или Ctrl + Z). Вы заметили, что все из-

менения могут быть просмотрены в режиме реального времени 
таким образом, что можно быть уверенным, что вы всё делаете 

правильно. 

Выберите объект на шкале времени и дважды щелкните 
по нему, чтобы открыть панель редактирования. Если вы вошли в 

режим редактирования, то можно переключаться на другой ме-
диафайл, чтобы редактировать его, не возвращаясь в панель - это 

сэкономит вам много времени. 

 
Редактирование видео/аудио 

Если дважды щёлкнуть какое-либо видео на временной 
шкале, то откроется панель с настройками видео и аудио, которая 

даёт возможность редактировать видео- и аудиодорожки файла. 
Помните, что для звуковых файлов отображаются только 
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настройки аудио. 

Обратите внимание: Если вы хотите поменять звуковую 

дорожку видеоклипа на собственный голос за кадром или на дру-
гую звуковую дорожку, то после добавления звукозаписи в шкалу, 

вам нужно выделить видео и щёлкните правой кнопкой мыши для 
выбора опции "Mute". 

 
Основные инструменты: Основной видеоинструментарий 

включают в себя обрезку, вращение (переворот), настройки (яр-

кость, насыщенность, оттенок) и скорость (быстрое и медленное 
движение), в аудиоинструментарий состоит из громкости, усиле-

ния/затихания звука и тональность. Для настроек видео и аудио 
используются обычные ползунки. Можно сразу видеть результат в 

окнах предварительного просмотра. Если вы не довольны резуль-

татом, то нажмите кнопку "Reset" и сделайте новую попытку. 
Автоматическое улучшение: Выбрав опцию Enhance в па-

нели редактирования видео, вы для выбранного видео-объекта 
включите режимы автоматического понижения уровня шума и 

автоматического улучшения видео. 
Вырезать видео/аудио: Наведите курсор мыши на левый 

или правый край видео или аудио на шкале, и когда появится 

"двойная стрелка" перетащите его до любой длины. 
Отделить аудио от видео: Для отделения аудио от видео, 

просто щёлкните на видео правой кнопкой мыши и выберите в 
всплывающем меню "Audio Detach" - отделённая звуковая дорож-

ка автоматически появится на шкале для аудио. 

 
Редактирование фото 

Есть две категории инструментов редактирования фото: 
Photo и Motion. Категория Photo предоставляет такие основные 

инструменты редактирования, как обрезка, вращение (переворот) 

и несколько инструментов настройки. В категории Motion любую 
статичную фотографию можно превратить в анимированную, ис-

пользуя до 36 эффектов движения (эффектов Кена Бёрнса). Для 
применения эффекта надо дважды щёлкнуть на нём. Чтобы уда-

лить добавленное движение, щёлкните правой кнопкой мыши на 
эскиз на временной шкале и выберите "Delete Motion". 

Наложить голос 

Довольно удобно накладывать голос на фильм. На панели 
инструментов над шкалой, нажмите Record, чтобы вызвать диало-

говое окно Record Audio ("Запись звука"). Нажмите Start и у вас 
будет 3 секунды перед тем, как начать говорить. Закончив, 
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нажмите Stop. Чтобы начать новый запись на временной шкале, 

нет необходимости закрыть диалоговое окно - просто перемести-

те индикатор времени в другое положение и снова нажмите Start. 
Добавление крупного плана, скачков и прочих эффектов 

Применение крупного плана 
Чтобы применить крупный план к своему видео, просто 

щёлкните мышкой видеофайл на шкале, затем на панели инстру-
ментов вверху нажмите вторую иконку справа. В начало клипа 

будет автоматически добавлен сегмент выделению мышкой. 

Нажмите и перетяните область выделения в нужное место. 
Добавление эффектов скачков, наклона и сдвига, мозаики 

и вбрасывания 
Добраться к этим функциям можно, щёлкнув мышкой на 

видеофайл на временной шкале, затем на панели инструментов 

прямо над шкалой, нажмите самую правую кнопку. Появится ок-
но, в котором можно выбрать любой из этих четырёх эффектов. 

Добавление титров, эффектов и заставок 
Добавлять в фильм титры, эффекты и заставки довольно 

легко. Просто перейдите на одну из вкладок Text, Effect или 
Intro/Credit, а затем перетащите элемент на временную шкалу. 

Можно сразу просматривать новое видео. При необходимости 

можно дважды щёлкнуть добавленный элемент, чтобы его 
настроить, например, продолжительность. 

Редактирование титров 
Выбрав нужный стиль титров, можно дважды щёлкнуть по 

нему и оформить содержимое, установить шрифт, цвет, анимацию 

и т.д. После завершения нажмите Return, чтобы вернуться в ос-
новной интерфейс. 

Редактирование эффектов 
Более 50 визуальных эффектов способны за считанные 

секунды поднять видео на новый уровень. Добавленный эффект 

будет применён к видео или фото. На некоторых эффектах можно 
дважды щёлкнуть мышкой, чтобы изменить параметры. 

Редактирование заставки 
Заставка может быть добавлена в любую позицию вре-

менной шкалы для создания в вашем фильме разделов, заставок, 
признаний и списка актёров. На самом деле, заставка представ-

ляет собой сочетание фото и титров. На них тоже можно дважды 

щёлкнуть, чтобы начать редактировать так же, как и в случае ре-
дактирования фотографий и титров. 

Добавление переходных эффектов 
Если вы хотите добавить какие-либо переходы между ва-
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шими фото или видеоклипами, вы можете перейти на вкладку 

Transition над шкалой, а затем перетащить нужный эффект пере-

хода в область между двумя клипами. Чтобы получить предвари-
тельный просмотр какого-либо эффекта перехода, надо навести 

на него курсор мыши, а чтобы просмотреть в более крупном раз-
мере в правом окне, дважды щёлкнуть по нему. 

При добавлении эффектов перехода можно щёлкнуть пра-
вой кнопкой на любом из них и выбрать, применить ли его ко 

всем фалам или применить ко всем переходы в случайном поряд-

ке. 
Советы: Выбранный переход можно добавить в избран-

ные, чтобы потом было легче его найти. Дважды щёлкнув на пе-
реходе на временной шкале, можно вручную настроить его про-

должительность и применить её для всех остальных объектов. 

Сделать PIP-видео (картинка в картинке) 
Картинка в картинке - это дополнительный видеоклип или 

изображение, встроенные в основное видео или рядом. 
Wondershare Video Editor теперь позволяет создавать привлека-

тельные PIP-видео несколькими щелчками мыши. 
Просто перетащите импортированное видео/фото или из-

бранный объект на вкладке PIP на шкалу PIP - и есть контакт! Вы 

получили PIP-video. Потом дважды щёлкните на PIP-объекте, что-
бы установить эффект перехода для своего PIP-видео/фото. Мож-

но даже, нажав на кнопку Advanced, применить дополнительные 
эффекты, такие как тень, рамка, альфа-канал и маска. 

 

Сохранить и поделиться своим видеотворением 
Закончив редактирование, нажмите Export и выберите 

внизу способ вывода своего видео: Device (Устройство), Format 
(Формат), YouTube и DVD. 
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Рис. 6.5. Окно Wondershare Video Editor 

 

1. Устройство: Выберите из списка., чтобы получить опти-
мизированное под своё устройство видео. Назовите видео и ука-

жите папку. А затем нажмите Export, чтобы сохранить видео в 

указанную папку. Предусмотрены расширенные настройки, такие 
как видео- и аудиокодер, частота кадров, битрейт и т.п. (Нажмите 

на маленькую треугольную кнопочку). 
2. Формат: Выведите видео в любой популярный ви-

деоформат, такой как AVI, WMV, MOV, FLV, MP4, MKV, MPEG и т.д. 

Потом укажите имя вашего видео и выберите путь вывода, а за-
тем нажмите Export , чтобы начать сохранять файл. 

3. YouTube/Facebook: Позволяет напрямую обмениваться 
своей работой на YouTube или Facebook. Внесите информацию о 

своём аккаунте и видео, такую как категория, название, описание 

и т.п., чтобы поделиться своим творением с большим количеством 
людей на YouTube или Facebook. 

4. DVD: Установите параметры DVD, такие как этикетка, 
качество видео, ТВ стандарт и пропорции, а затем запишите 

фильмы на DVD или сохранить видео в файл ISO-образа. 
 

Работа с видео на примере программы Windows 

Movie Maker 2.6 
Windows Movie Maker – это бесплатная программа для со-

здания и редактирования любительских фильмов, которая входит 
в комплект операционных систем семейства Microsoft Windows. С 
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помощью этой программы можно создавать монтировать и демон-

стрировать свои фильмы прямо на домашнем ПК при выполнении 

простых операций перетаскивания мышью. Программа позволяет 
добавлять специальные эффекты, дикторский текст и музыку. По-

сле создания фильма Вы сможете записать его и отослать друзьям 
и знакомым. 

Данная программа довольно проста в использовании и в 
первую очередь она рассчитана на любительское создание филь-

мов. Но не следует считать простоту программы ее недостатком, а 

скорее, наоборот. Безусловно, что в качестве видеоредактора 
программа Windows Movie Maker слабовата, но вот в качестве 

программы для создания слайдшоу это приложение как раз то, 
что нужно. В некоторых аспектах этой программе уступают даже 

профессиональные приложения для создания видео. 

1. Программа Windows Movie Maker 2.6 (рис.6.6)  

 
Рис. 6.6. Окно Windows Movie Maker 2.6 

 
Рассмотрим её: 

Главное меню содержит все команды и настройки для 
управления работой программы. С его помощью можно вклю-

чать/отключать некоторые панели программы или вызывать нуж-

ные функции. Ниже, расположена панель инструментов, которая 
имеет кнопки для создания/открытия/сохранения проекта, отме-

ны/повторений действий, скрытия/отображения панели задач 
(Tasks), скрытия/отображения панели сборники (Collections), а 

также выпадающий список, в котором можно выбрать необходи-

мую группу элементов. Групп там всего три: Video Effects (Виде 
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эффекты), Video Transitions (Видео переходы), Collections (Сбор-

ники). 

Пожалуй, одним из наиболее удобных решений, облегча-
ющих доступ к функциональным возможностям программы, без 

которого в Windows Movie Maker было бы работать намного слож-
нее, является панель задач (Рис 6.7.). 

 

 
Рис. 6.7– Панель задач программы Windows Movie Maker 2.6 

 

Данная панель предназначена для упрощения доступа к 

наиболее часто используемым командам. По сути, панель задач 
разбита на три раздела: 

1. Capture Video (Запись видео), тут есть три пункта для им-
порта видео (Import video), картинок (Import pictures) и звука 

(Import audio or music) в "рабочее поле" программы. 

2. Edit Movie (Монтаж фильма). Здесь находится пять эле-
ментов, с помощью которых можно отображать окна сборников 

(Show Collections), видеоэффектов (View video effects), переходов 
(View video transitions), а также окна для создания названий тит-

ров (Make titles or credits) и создания автофильма (Make an 
AutoMovie). 

3. Finish Movie (Завершение создания фильма). В этой кате-

гории находятся функции для создания фильма и сохранения его 
на компьютере (Save to my computer) или на видеокамере (Send 

to DV camera). 
Теперь давайте рассмотрим окно проекта (Рис 6.8.) в кото-

ром отображаются сборники (Collections), видео эффекты 
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(Video Effects) и переходы (Video Transitions). Для переключения 

между этими группами элементов необходимо выбрать соответ-

ствующий пункт из выпадающего списка инструментов или из 
списка на панели задач. Также в этой области программы отоб-

ражается окна для создания заголовков (Make titles or credits) и 
автофильма (Make AutoMovie). 

 

 
Рис. 6.8– Окно проекта Windows Movie Maker 2.6 

 
Для просмотра содержимого сборников, видео эффектов и 

переходов удобно использовать встроенный проигрыватель (Рис 
6.9). Также он предназначен для отображения созданного Вами 

проекта, который можно посмотреть в полноэкранном режиме 
нажав в главном меню во вкладке "View" (вид) на пункт "Full 

Screen" (на весь экран) или просто нажав на комбинацию клавиш 

Alt + Enter. 
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Рис. 6.9. Проигрыватель программы Windows Movie Maker 2.6 

 

Внизу программы находится панель, в которой доступны два ре-
жима просмотра проекта (Рис 6.10.). 

 
Рис. 6.10– Нижняя панель программы Windows Movie Maker 2.6 

 
Первый режим имеет вид типичной шкалы времени (см. 

Рис. 6.11). В основном этот режим используется для подбора и 
упорядочивания слайдов, изменения продолжительности их про-

игрывания, добавления заголовков, звука и видеоэффектов. 
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Рис. 6.11. Шкала времени 

 

Второй режим имеет вид раскадровки (Рис. 6.12). Этот 
режим удобен при добавлении переходов и видео эффектов. 

 
Рис. 6.12. Режим раскадровки 

 

Переключаться между режимами можно нажимая кнопки с 
надписями "Show Timeline" и "Show Storyboard" или с помощью 

комбинации горачих клавиш Ctrl+T. 

Работа с программой 
1. Запуск программы. По умолчанию запустить программу 

можно нажав кнопку "Пуск", далее необходимо перейти в меню 
"Программы" и выбрать там "Windows Movie Maker 2.6". 

2. Импорт содержимого. На панели инструментов нажима-

ем, к примеру "Import pictures" (Импорт изображений) и выбираем 
несколько изображений. После того как вы выберете необходи-

мые изображения они будут отображены в окне проекта 
Collections (Сборники). Таким же образом Вы сможете добавить 

видео, или аудио информацию просто нажав пункты "Import 
video", "Import audio or music" соответственно. 

3. Добавление объектов на шкалу времени. Теперь из ок-

на проекта Collections (Сборники) перетаскиваем объекты на шка-
лу времени. Которые кстати можно добавить нажав на пункт ме-

ню, разворачивающееся при клике правой кнопкой мыши "Add 
TimeLine" (Добавить на шкалу времени) или просто нажав комби-
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нацию горячих клавиш "Ctrl + D". Также в панели задач есть до-

вольно полезный пункт под названием "Make an AutoMovie" (Со-

здание автофильма), который поможет вам автоматически доба-
вить все объекты, находящиеся в окне проекта Collections (Сбор-

ники). 
4. Добавление названий и титров. Это, пожалуй, самая ин-

тересная возможность программы Windows Movie Maker, которая 
позволяет создавать замечательные короткометражные фильмы. 

Для того чтобы добавить заголовок необходимо в панели задач в 

категории "Edi Movie" выбрать пункт "Make titles or credits" (Со-
здание названий и титров) или в главном окне во вкладке "Tools" 

(Сервис) выбрать пункт "Titles and Credits…" (заголовки и титры). 
После чего в появившемся окне можно будет выбрать место в 

клипе, которое будет присвоено новой надписи: в начале, в кон-

це, перед выделенным объектом, после выделенного объекта или 
на выделенном объекте. Далее следует выбрать нужный пункт и 

заполнить текстовое поле. Также можно задать шрифт и способ 
анимированного отображения надписи. 

5. Добавление видео эффектов и переходов. Для того 
чтобы добавить видеоэффекты и переходы необходимо для нача-

ла выбрать из панели задач пункт View video effects (Просмотр 

видео эффектов) или View video transitions (Просмотр видео пере-
ходов), после чего откроется окно с наглядно представленными 

небольшими миниатюрами эффектов (или переходов). Вы можете 
посмотреть их в работе просто выбрав любую миниатюру и эф-

фект автоматически проиграется во встроенном плеере. Для до-

бавления понравившихся элементов можно просто перетянуть их 
на нужный кадр. Эффекты и особенно переходы очень удобно 

добавлять в режиме раскадровки. 
6. Редактирование фильма в окне шкалы времени. После 

добавления элементов следует установить длительность их про-

игрывания. Это можно сделать, выделив на шкале времени нуж-
ный объект и потянув его за края. Следует помнить о том, что 

если вы хотите, чтобы при отображении, например, картинки од-
новременно показывался какой-либо текст, то необходимо уде-

лить внимание задаваемому для проигрывания времени. Так, 
например, при добавлении текста, который будет занимать на 

экране максимальное пространство, для картинки следует уста-

навливать время проигрывания около 15 секунд плюс 2 секунды 
на переходы. При определении продолжительности проигрывания 

лучше всего засеките секундомером, сколько Вам нужно времени 
для спокойного чтения заголовка. Для более удобной настройки 
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воспользуйтесь функцией изменения масштаба, с помощью кото-

рой можно более точно и легко установить временные рамки для 

отображения тех или иных объектов. Для этого можно воспользо-
ваться кнопками с изображением лупы или горячими клавишами 

Page Down и Page Up. Также при редактировании следует уделить 
особое внимание музыкальному сопровождению. Установите 

плавное нарастание проигрывания аудио-сопровождения в нача-
ле и затухание, в конце нажав на правую кнопку мыши в шкале 

времени над дорожкой "Audio" и выбрав пункты "Fade In" (нарас-

тание) и "Fade Out" (затухание). Плюс ко всему в том же выпада-
ющем меню можно настроить громкость, выбрав пункт "Volume". 

7. Сохранение и создание фильма. Последним этапом в 
работе с программой Windows Movie Maker будет создание и со-

хранение видеоклипа. Для этого Вам необходимо будет просто в 

панели задач выбрать пункт "Save to my computer" (Сохранение 
на компьютере) или "Send DV camera" (Отправить на цифровую 

камеру). Потом следуйте подсказкам мастера и наслаждайтесь 
просмотром созданного клипа. 

Задание 1. Ваш Первый Фильм 
Изучим работу программ и самостоятельно создадим ви-

део. 

 
Контрольные вопросы  

 
1. Понятие мультимедиа.  

2. Виды мультимедийных устройств.  

3. Понятие мультимедийных программ.  
4. Виды мультимедийных программ.  

5. Возможности программы создания видео.  
6. Технология создания видеоклипа.  

7. Назначение Шкалы времени.  

8. Назначение Шкалы раскадровки.  
9. Дорожки, входящие в состав Шкалы времени.  

10. Способы сохранения фильма.  
11. Аналоговое видео. 

12. Цифровое видео. 
13. Основные характеристики цифрового видео. 

14. Виды сжатия видеоданных. 

15. Форматы видео. 
16. Видеомонтаж. 

17. Устройство и принцип работы видеокарт. 
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ЛАБОРАТОРНАЯ РАБОТА № 7 СОЗДАНИЕ МУЛЬТИМЕДИА 

ПРЕЗЕНТАЦИИ 

 
Цель работы исследовать технологию создания мультимедиа 

презентации в пакете Microsoft Power Point. 
 

Краткие теоретически сведения 

Мультимедийная презентация – это современное и эффек-
тивное средство позиционирования и привлечения бизнес-

партнеров и клиентов. Использование мультимедийной презента-
ции также позволяет сформировать свой собственный уникальный 

имидж, решать не только различные задачи по продвижению 

компании, ее товаров и услуг, но и задачи, связанные с выста-
вочной деятельностью или публичными выступлениями и докла-

дами. Создаваемый аудио, видео, фотографический ряд обеспе-
чивает эффектное и интересное восприятие информации. 

В состав мультимедийной презентации могут входить сле-
дующие компоненты: цифровые фото изображения; форматиро-

ванный текст; компьютерные рисунки и анимация; элементы 

трехмерной графики; аудио звук, голосовое сопровождение; ви-
део зарисовки, сюжеты, фильмы. 

В программе PowerPoint к различным объектам можно 
применять анимацию. Это позволить её «оживить» и сделать её 

оригинальной. Чтобы добавить анимацию к определенному объ-

екту, нужно его выделить, перейти на ленту «Анимация». После 
этого нужно открыть меню анимаций и выбрать тот эффект, кото-

рый наиболее соответствует вашим требованиям. Выделяя раз-
личные эффекты мышкой, на слайде будет происходить пред про-

смотр. После определения с нужным эффектом, можно будет 

настроить его параметры: длительность эффекта, его задержку и 
момент начала анимации (она может запускать после щелчка 

мышью, одновременно с предыдущей анимацией и после завер-
шения предыдущей анимации). То есть, если на ваших слайдах 

будет несколько объектов анимации, вы можете выстроить авто-
матическую цепочку, при которой каждая последующая анимация 

будет начинаться после завершения предыдущей. 

К изображению можно применять дополнительные эффек-
ты. Для этого необходимо выделить картинку и перейти на вклад-

ку «Формат». Тут можно выбрать окантовку рисунка и применить 
к нему дополнительные эффекты. 

Для того чтобы вставить звук или видео в презентацию 
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нужно опять перейти на ленту «Вставка» и в группе «Мультиме-

диа» выбрать нужный пункт: либо видео, либо звук. Вставка 

мультимедиа аналогична вставке изображения. Точно так же от-
крывается проводник (выпадает окно вставки), выбирается нуж-

ный файл и вставляется в презентацию. С объектами видео мож-
но выполнять все операции, что и с изображениями: изменять 

размер, перемещать по слайду. 
 

Этапы разработки мультимедийного продукта  

I этап - выбор темы и описание проблемы; 
II этап - анализ объекта;  

III этап - разработка сценария и синтез модели;  
IV этап - форма представления информации и выбор про-

граммных продуктов; 

V этап - синтез компьютерной модели объекта 
 

Подбор материала, подготовка доклада и сценария презен-
тации 

Включает следующие этапы: 
1. Выбор темы. 

2. Сбор материала по выбранной теме 

3. Составление устного доклада на 5 мин. 
4. Разработка сценария презентации по указанной форме 

 
5. Оформление презентации в Microsoft PowerPoint. 
6. Проведение презентации перед группой 

 
Порядок выполнения работы. 

 

Для размещения файлов, полученных при выполнении ра-
боты, создайте в своей папке папку DemoPrezent. В ней создайте 

ещё папки: 
Text - для размещения  текстового  материала презентации, 

picture – для размещения  графического материала презен-
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тации,  

sound –для размещения  звукового материала презентации, 

video – для размещения видео материала презентации ре-
ферата.  

 
Задание 1 

Создайте презентацию, содержащую слайд-заставку, 
слайд-оглавление, не менее 5-6 информационных слайдов. В ин-

терфейсе пользователя предусмотрите возможность перехода со 

слайда-оглавления на любой слайд и обратно; связи между ин-
формационными слайдами; в информационные слайды включите 

помимо текстового материала графику, звук, видео; в презента-
ции организуйте не только текстовые, но и графические  гиперс-

сылки. 

 
Для этого: 

I. Проведите подготовительную работу: 
1) Выберите тему, определите цель презентации. 

2) Разработайте структуру презентации. 
3) Разработайте сценарий презентации. 

4) Разработайте дизайн презентации. 

 
II. Подготовьте данные для презентации, разместив их в 

папке. 
1) Подготовьте текстовые материалы. 

2) Подготовьте графические материалы. 

3) Подготовьте звуковые материалы. 
4) Подготовьте  видео материалы. 

 
III. Создайте слайды презентации. 

1) Создайте (выберите) дизайн слайдов будущей презен-

тации. 
2) Создайте слайд - заставку, включив в него тему и цель 

презентации. 
3) Создайте слайд-содержание, включив в него оглавле-

ние слайдов презентации. 
4) Создайте информационные слайды: 

a)        Выберите разметку слайда. 

b)        Вставьте текст. 
c)        Вставьте рисунки. 

d)        Вставьте видео и звук. 
e)        Настройте анимацию объектов. 
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IV. Проведите настройку презентации. 

1) Создайте связи между слайдами.  

2) Настройте переходы между слайдами. 
3) Установите время демонстрации. 

 
V. Создайте страницы заметок. 

Для каждого слайда в текст заметок включите материал 
необходимый при проведении демонстрации. 

 

Выполните отладку презентации: 
– проверку на наличие и правильность порядка следования;  

– проверку на наличие ошибок; 
– проверку на однородность дизайна слайдов; 

– проверку на работоспособность объектов и гиперссылок. 

 
Задание 2. Подготовьте раздаточные материалы и 

проведите демонстрацию презентации. 
 

Распечатайте: 
– раздаточные материалы (по 4 слайда на листе); 

– страницы заметок. 

 
Проведите демонстрацию презентации.  

 
Основные требования, предъявляемые к устному до-

кладу: 

 Доклад должен точно соответствовать выбранной теме и 
полностью ее раскрывать. 

 Объем текста доклада должен соответствовать регламенту 
презентации (5 мин. примерно 1,5 страницы печатного текста при 

среднем темпе речи). 

 Доклад должен быть адаптирован к устной речи. 
 Доклад должен начинаться с приветствия, представления 

автора и темы, обозначения краткого плана. 
 

Оформление мультимедийной презентации при по-
мощи Microsoft Office PowerPointспе 

 Требования к мультимедийной презентации в формате 

Microsoft Office PowerPoint: 
 Текст на слайдах не должен дословно повторять текст до-

клада. 
 Текст на слайдах должен быть разборчивым: следует об-
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ратить внимание на выбор шрифтов и размера символов. 

Выбирая шаблон оформления (стиль) презентации следует 

учитывать его соответствие теме, аудитории и способу проведе-
ния (демонстрация через проектор требует более контрастных 

сочетаний фона и текста).  
На слайды в обязательном порядке выносятся: 

 a. графический материал, иллюстрирующий доклад: ри-
сунки, фотографии, схемы и т. д.; 

 b. все приведенные в докладе даты и числа, аббревиатуры 

с расшифровкой, имена собственные, имена и термины на ино-
странных языках с переводом; 

 c. термины и другие понятия, на которые в докладе дела-
ется акцент; 

 d. другие материалы, тяжело воспринимаемые на слух. 

 
Первым слайдом презентации должен быть титульный 

слайд, на который выносятся тема и имя автора. В случае если 
авторов несколько   имя докладчика подчеркивается. 

 Втором слайде приводится краткий план презентации  
(3-5 пунктов). 

Подбор материала для слайда необходимо вести таким об-

разом, чтобы не перегружать его: один слайд, как правило, не 
должен оставаться на экране дольше 1 мин. Также не следует 

стремиться к слишком частой смене слайдов (менее 15-20 сек па 
слайд). 

 В случае отсутствия графического материала для слайда 

на него выносятся тезисы автора. 
 

Презентация должна способствовать концентрации внима-
ния зрителя на докладе: следует стремиться к постепенному вы-

воду требуемых материалов на экран в точном соответствии с 

темпом доклада. 
 Использование эффектов анимации (звука, видео) должно 

быть направлено исключительно на акцептирование внимания 
зрителя на каких-либо моментах доклада. 

 В конце презентации приводится слайд со ссылками на 
использованные источники. 

 Последним обычно располагают слайд с благодарностью 

зрителям за внимание и контактной информацией об авторах. 
 

Контрольные вопросы  

1. Этапы создания мультимедиа-проектов. 
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2. Классификация  программного обеспечения для создания 

мультимедиа-проектов. 

3. Примеры реализация средств мультимедиа технологии 
4. Для чего предназначен графический пакет Microsoft 

PowerPoint? 
5. Какие материалы может получить пользователь в результа-

те разработки презентации с использованием пакета? Каково их 
назначение?  

6. Как запустить PowerPoint? 

7. Какие способы создания презентаций предоставляются 
пользователю? 

8. Как создать презентацию с помощью Мастера автосодержа-
ния? 

9. Как создать презентацию с помощью Шаблона презента-

ции? 
10. Что задает Шаблон дизайна? 

11. Что задает Шаблон презентации? 
12. Как создать презентацию с помощью Пустой презентации? 

13. Для чего используется Авторазметка слайда? 
14. Какие режимы отображения презентации существуют? 

15. Как можно переключаться между различными режимами? 

16. Как отображается презентация в режиме слайдов? Для чего 
его можно использовать? 

17. Как отображается презентация в режиме структуры? Для 
чего его можно использовать? 

18. Как отображается презентация в режиме сортировщика 

слайдов? Для чего его можно использовать? 
19. Как отображается презентация в режиме страниц заметок 

слайдов? Для чего его можно использовать? 
20. Как отображается презентация в режиме показ слайдов? 

Для чего его можно использовать? 

21. Как создать фон слайда? Какие режимы можно использо-
вать? 

22. Как создать текст слайда? Какие режимы можно использо-
вать? 

23. Как вставить рисунок в слайд?: Какие режимы можно ис-
пользовать? 

24. Как создать рисунок в слайде?: Какие режимы можно ис-

пользовать? 
25. Как вставить видео (звуковой) объект? Какие режимы мож-

но использовать? 
26. Как создать гиперссылку  в слайде?: Какие режимы можно 
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использовать? 

27. Как добавить управляющую кнопку  в слайд?: Какие режи-

мы можно использовать? 
28. Как настроить анимацию объекта слайда с помощью панели 

Эффекты анимации?: Какие режимы можно использовать? 
29. Как настроить анимацию текста слайда с помощью команды 

Настройка анимации?: Какие режимы можно использовать? 
30. Как настроить анимацию рисунка слайда с помощью коман-

ды Настройка анимации?: Какие режимы можно использовать? 

31. Как настроить анимацию управляющей кнопки с помощью 
команды Настройка анимации?: Какие режимы можно использо-

вать? 
32. Как настроить анимацию звукового объекта с помощью ко-

манды Настройка анимации?: Какие режимы можно использовать? 

33. Как настроить анимацию видео объекта с помощью коман-
ды Настройка анимации?: Какие режимы можно использовать? 

34. Как настроить анимацию диаграммы с помощью команды 
Настройка анимации?: Какие режимы можно использовать? 

35. Как настроить действие объекта? Какие режимы можно ис-
пользовать? 

36. Как настроить переходы между слайдами? Какие режимы 

можно использовать? 
37. Как установить время перехода слайдов? Какие режимы 

можно использовать? 
38. Как скрыть слайд? Какие режимы можно использовать? 

39. Как переставить слайды? Какие режимы можно использо-

вать? 
40. Как добавить/удалить слайд? Какие режимы можно исполь-

зовать? 
41. Как создать страницы заметок? Какие режимы можно ис-

пользовать? 

42. Как проверить текст презентации на наличие ошибок? Ка-
кие режимы можно использовать? 

43. Как провести демонстрацию презентации? 
44. Для чего предназначено контекстное меню демонстрации? 

Как его открыть? 
45. Как сделать пометки на слайде во время демонстрации? 

46. Как распечатать слайды презентации? 

47. Как распечатать раздаточные материалы? 
48. Как распечатать страницы заметок? 

49. Как распечатать структуру презентации? 
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